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CAUTION!

Fathom is a sophisticated pipe flow analysis program designed for qualified
engineers with experience in pipe flow analysis and should not be used by
untrained individuals. Fathom is intended solely as an aide for pipe flow analysis
engineers and not as a replacement for other design and analysis methods,
including hand calculations and sound engineering judgment. All data generated
by Fathom should be independently verified with other engineering methods.

Fathom is designed to be used only by persons who possess a level of
knowledge consistent with that obtained in an undergraduate engineering course
in the analysis of pipe system fluid mechanics and are familiar with standard
industry practice in pipe flow analysis.

Fathom is intended to be used only within the boundaries of its engineering
assumptions. The user should consult the Fathom Help system for a discussion
of all engineering assumptions made by Fathom.

Information in this document is subject to change without notice. No part of this Quick Start
Guide may be reproduced or transmitted in any form or by any means, electronic or mechanical,
for any purpose, without the express written permission of Applied Flow Technology.

© 2025 Applied Flow Technology LLC. All rights reserved.

“AFT Fathom”, “Applied Flow Technology”, “Dynamic solutions for a fluid world”, and the AFT
logo are trademarks of Applied Flow Technology LLC.
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and PDS are trademarks of Intergraph Corporation / Hexagon AB. ROHR2 is a trademark of
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C H A P T E R 1

Introducing Fathom

Welcome to Fathom, Datacor’s powerful pipe and duct flow modeling tool.
With Fathom you can model incompressible flow in complex pipe and duct
networks, including coupled heat transfer in pipes and ducts, heat exchangers,
pumps, and the resultant effect on fluid properties such as viscosity.

Fathom has four available Add-on Modules for purchase which extend the
modeling capabilities into new areas.
� The Goal Seek & Control (GSC) module allows the engineer to perform

multivariable goal seeking and simulate control system functions.
� The Extended Time Simulation (XTS) module allows the engineer to model

time-varying system behavior via a series of steady-state snapshots.
� The Settling Slurry (SSL) module allows the engineer to perform the

complex property and system interaction calculations associated with
settling slurry flows.

� The Automated Network Sizing (ANS) module automates the process of
sizing pipes and ducts in a complex network based on design requirements,
such as maximum pressure or minimum flow, to reduce cost or weight.

Modeling capabilities

Standard version capabilities
� Open and closed (recirculating) systems

� Network systems that branch or loop, with no limit on the number of loops

� Pressure driven systems and gravity fed systems

� Pumped systems, including multiple pumps in parallel or in series

� Pumps with variable speed, controlled pressure, controlled flow, viscosity
corrections, and multiple stages with takeoff flow

� Systems with pressure and/or flow control valves

� Systems with valves closed and/or pumps turned off

� Heat transfer and system energy balance

� Systems with variable density and viscosity
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� Multiple design cases in a single model file

� Non-Newtonian fluid behavior

� Cost calculation of pump energy usage

Add-on module capabilities (optional)
� Multivariable goal seeking and control simulation (GSC)

� Time-varying system modeling (XTS)

� Pump starting and stopping over time (XTS)

� Valve opening and closing over time (XTS)

� Tank liquid level changes automatically calculated (XTS)

� System performance calculations for settling slurries (SSL)

� Automated design of a piping network (ANS)

Fathom provides hundreds of standard loss values from handbook sources for
pipe system components, and also allows the engineer to enter their own loss
data. Variable loss models that depend on flow are supported.

Fathom's powerful solution engine is based on standard techniques used for
many years in industry. The Newton-Raphson method is used to solve the
fundamental equations of pipe flow that govern mass and momentum balance.
Solutions are obtained by iteration, and matrix methods optimized for speed are
employed to obtain convergence.

Engineering assumptions in Fathom

Fathom is based on the following fundamental fluid mechanics assumptions:
� Incompressible flow

� Steady-state conditions (XTS Module consists of steady snapshots)

� One-dimensional flow

� System is fluid-full

� Fluid properties are single phase

� No chemical reactions

Thermophysical property data

Fathom offers several sources from which thermophysical properties can be
derived:
� ASME Steam/Water - Properties are calculated with the equations of state

from the IAPWS Industrial Formulation (1997), also used to generate the
ASME steam/water tables.
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� Chempak™ - Optional add-on for purchase which contains data for
approximately 700 fluids and supports user-specified fluid mixtures.
Chempak is licensed from Madison Technical Software.

� NIST REFPROP - The Reference Fluid Thermodynamic and Transport
Properties Database is licensed from the National Institute of Standards and
Technology (NIST) where properties for approximately 150 fluids are
calculated via equations of state. REFPROP supports user-specified fluid
mixtures.

� Fathom Standard - Common fluids from various industry standard sources
have been curve fit to optimize calculation speed.

� User Specified Fluid - Custom fluid properties can be entered if the desired
working fluid is not available via the other sources. Fathom requires density
and viscosity at a minimum. Vapor pressure can be optionally entered to
check for cavitation.

� User Library Fluid - A custom fluid can be saved to the User Library for
repeated use in the future. Heat transfer can be modeled if additional
parameters are specified.

Fathom Primary Windows

Fathom has several Primary Windows that work in an integrated fashion. Each is
located on a separate, moveable tab. You work exclusively from one of these
windows at all times. For this reason, they are referred to as Primary Windows.

Workspace
The Workspace Primary Window is where the user creates the graphical
representation of the system. Engineering data is input on pipe and junction
property windows which are opened by double-clicking the objects.

The Workspace Layers are also located on this Primary Window and allow the
user to display both input and output data superimposed on the pipe system
schematic.

Model Data
The Model Data Primary Window summarizes the engineering input data from
the Workspace into categorized tables. This allows for easy review of the system
inputs, and double clicking cells will open the pipe or junction properties for
quick editing.

Output
The Output Primary Window offers a powerful and diverse range of features for
reviewing analysis results which are organized into categorized tables and lists.
The Output allows the user to easily compare multiple design scenarios with
color coded rows, details errors or design requirement violations, and prepare
the results for documentation.

3 Fathom 14 Quick Start Guide



Graph Results
The Graph Results Primary Window allows the user to create a wide array of
graphs with various parameters which are integral to gaining a deeper
understanding of the pipe system’s behavior. The user can adjust various
formatting settings such as axis ranges, labels, colors, and create dual y-axis or
stacked graphs. The settings can be saved into templates called Graph List Items
so that the graphs can be easily reproduced.

Input vs. Output
Table 1.1 summarizes how each Primary Window relates to input and output
data. The Workspace can display output data by using Workspace Layers after
the simulation has been run.

Table 1.1 Primary Window Input vs. Output Data

Primary Window Can Display Input Can Display Output

Workspace ✓ ✓

Model Data ✓

Output ✓

Graph Results ✓

Note: Fathom supports multiple monitors. You can click and drag any of the
Primary Window tabs off of the main Fathom window, where it can then be
moved anywhere on the screen, including onto a second monitor. To add the
Primary Window back to the main Fathom program window bar, simply close
the Primary Window.

Note: To ensure that your results are the same as those presented in this
documentation, these examples should be run using default Fathom settings,
unless you are specifically instructed to do otherwise.
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C H A P T E R 2

Sizing a Pump Example

This example demonstrates a sample calculation to size a pump for a specified
system.

Topics covered
� Model building basics

� Entering Pipe and Junction data

� Specifying Fluid properties

� Specifying Output Control

� Using Workspace Layers

� Graphing results

� Sizing a pump and entering pump curve data

Required knowledge

No prior knowledge is required for this example.

Model file

This example is intended to be built from scratch to help familiarize yourself
with the steps to define a complete model in Fathom. For reference purposes
only, the completed example model file can be found in the Examples folder as
part of the Fathom installation:

C:\Users\[username]\Documents\Datacor\Fathom 14\Examples
� Metric - Sizing a Pump.fth

Problem statement

A pump transfers water from a supply reservoir to a holding reservoir at the top
of a hill. The system consists of a supply reservoir, a pump, a discharge
reservoir, and two pipes.
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The first pipe from the supply reservoir to the pump is 3 meters long, and the
second pipe leading from the pump to the discharge reservoir is 300 meters long.
Both pipes are Steel - ANSI, 4 inch diameter (10.2 cm ID), and STD (schedule
40). Assume constant fluid properties.

The supply reservoir surface pressure is 0 barG (0 kPa (g)), and the liquid
surface is at an elevation of 3 meters. The discharge reservoir surface pressure is
0 barG (0 kPa (g)), and the liquid surface is at an elevation of 60 meters. The
pipes for both reservoirs connect at a depth of 3 meters below the liquid surface.

Determine the head requirement for a pump to supply flow in this system at 115
m3/hr.

Step 1. Start Fathom
► To start Fathom, open the all applications list in the Windows Start Menu,

expand the Fathom 14 folder, and choose Fathom 14 to launch the application.
This refers to the standard menu items created by a standard installation.

As Fathom starts, the Fathom Startup Window appears, as shown in Figure 2.1.
This window provides you with several options to choose from before you start
building a model.

Figure 2.1 Startup Window with Modeling Preferences collapsed

Some of the actions available are:
� Open a recent model, browse to a model, or browse to an example

� Activate an Add-on Module
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� Select ASME Water or a recently used fluid

� Review or modify Modeling Preferences: select a Unit System, filter units,
choose a Grid Style, select a Default Pipe Material, and more

� Access other Resources such as Help Files and Video Tutorials

The first time Fathom launches, Modeling Preferences will be expanded in the
middle section of the Startup Window, as shown in Figure 2.2. Otherwise, the
Startup Window will appear with Modeling Preferences collapsed, as shown in
Figure 2.1.

When collapsed, you can view your current Modeling Preferences at the bottom
of the Start a New Model section. To further review or adjust your preferences,
click the Modify button (see Figure 2.1).

Figure 2.2 Startup Window with Modeling Preferences expanded

► With Modeling Preferences expanded, as in Figure 2.2, select Both with
Metric Defaults under Unit System. The Filter section can be used to limit the
number of units that are shown in the interface.

The Common Plus Selected Industries option adds units from the industries you
select. You can use the Show Sample Units option to see the model units based
on your selections. After modifying your Modeling Preferences, click
Remember My Preferences and Hide.

► Click Start Building Model.
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The Workspace window is shown initially, as seen in Figure 2.3. The tabs in the
Fathom window represent the Primary Windows. Each Primary Window
contains its own toolbar displayed directly beneath the Primary Window tabs.

The Workspace window
The Workspace window is the Primary Window for building your model. This
window has three main areas: the Toolbox, the Quick Access Panel, and the
Workspace itself. The Toolbox consists of the object icons on the far left. The
Quick Access Panel is on the far right and gives easy access to the Scenario
Manager, object Properties, and Workspace Layers.

Figure 2.3 The Workspace Primary Window

You will build your model on the Workspace using the Toolbox. The Pipe
Drawing tool on the upper-left is used to draw new pipes on the Workspace. The
Annotation tool beside it allows you to create annotations and auxiliary graphics.

Below the two drawing tools are the different types of junctions available in
Fathom. Junctions connect pipes and also influence the pressure or flow
behavior of the pipe system. Drag and drop any of the junction icons from the
Toolbox to add them to the Workspace.

Holding your mouse pointer over a Toolbox icon identifies the tool’s function.

Hiding the Quick Access Panel
By default, the Quick Access Panel is pinned to the Workspace window so it is
always displayed. The Quick Access Panel can be unpinned so it is only
displayed when the mouse is moved over a tab displayed on the right edge of the
Workspace window. Unpin the Quick Access Panel by clicking on the pin icon
displayed in the top-right corner of the Quick Access Panel (see Figure 2.3). The
Quick Access Panel will be pinned for the remainder of the examples in this
guide.
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Step 2. Build the model

To lay out this example model, you will place several junctions on the
Workspace. Then, you will connect the junctions with pipes.

A. Place a reservoir
► To start, drag a Reservoir junction from the Toolbox and drop it on the

Workspace. Figure 2.4 shows the Workspace with one reservoir.

Objects and ID numbers
Items placed on the Workspace are called objects. Fathom uses three types of
objects: pipes, junctions, and annotations.

All pipe and junction objects on the Workspace have an associated ID number.
Junctions are prefixed with the letter J, and pipes are prefixed with the letter P.
You can assign a name in the object’s Properties window, and the visibility of
both the name and ID number can be controlled through the use of Workspace
Layers. You can also drag the ID number/name text to a different location to
improve visibility.

The reservoir you created on the Workspace will take on the default ID number
of 1. You can change this to any desired integer between 1 and 99,999 that is
not already assigned.

Editing on the Workspace
You can move junctions on the Workspace to new locations. You can also cut,
copy, paste, and duplicate junctions from the Edit menu or using keyboard
shortcuts. Undo is available for most arrangement actions on the Workspace.

Figure 2.4 Pump Sizing model with the first junction placed
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B. Place the other junctions
Drag a Pump junction from the Toolbox and drop it somewhere to the right of
the Reservoir junction (see Figure 2.5).

If a new junction type you want to add already exists on the Workspace, you
have the option of duplicating that junction. You do this by choosing Duplicate
from the Edit menu or by using CTRL+D. Either duplicate the first reservoir or
drag a new Reservoir junction onto the Workspace. Place the new reservoir
somewhere to the right of the Pump junction (see Figure 2.5).

Note: The relative location of objects is not important. Pipe lengths and junction
elevations are defined through property windows. The relative object locations
on the Workspace establish the connectivity of the objects but have no bearing
on the actual length or elevation relationships.

Even if the icons do not line up exactly, the results will not change. However,
your model may have a better appearance if the icons do line up. You can align
the icons from the Arrange menu using the Align feature.

Your model should now appear similar to that shown in Figure 2.5.

Figure 2.5 Pump Sizing model with all junctions placed

► Before continuing, save your work. Press CTRL+S, use the Save button on the
Common Toolbar, or go to the File menu and select Save. Fathom models use
the *.fth file extension.

C. Draw a pipe between J1 and J2
Now that you have all of the junctions placed, you need to connect them with
pipes.
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Connecting Junctions with Pipes
► To create a pipe, click the Pipe Drawing Tool icon on the Toolbox. The mouse

pointer will change to a crosshair when you move it over the Workspace. Left-
click and drag to draw a pipe below the junctions, similar to that shown in
Figure 2.6.

The pipe object on the Workspace has an ID number (P1) shown near the center
of the pipe.

Figure 2.6 Pump Sizing model with the first pipe drawn

► To place the pipe between J1 and J2, click and drag the pipe so that the left
endpoint falls within the J1 Reservoir junction (see Figure 2.7). Next, grab the
right endpoint of the pipe and drag it until the endpoint falls within the J2 Pump
icon (see Figure 2.8).

Figure 2.7 Pump Sizing model with the first pipe partially connected
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Figure 2.8 Pump Sizing model with the first pipe fully connected

Reference positive flow direction
The arrow on each pipe indicates the reference positive flow direction for the
pipe. The direction does not influence the direction that the flow may go, it
influences sign convention only. If the direction of flow calculated by the Solver
is the opposite of this reference flow direction, then the output will show the
flow rate as a negative number.

You can reverse the reference positive flow direction by choosing Reverse
Direction from the Arrange menu, selecting the Reverse Pipe Direction button
on the Toolbar, or pressing F3.

Although the reference positive flow direction does not need to point in the
direction of the actual flow, when used with pumps, the reference direction
determines the suction side and discharge side of the pump. Therefore, for the
remainder of this example make sure the positive flow direction of Pipe P1
points from the J1 Reservoir to the J2 Pump.

Note: Examples of other junctions that depend on pipe directions include
Control Valves, Check Valves, and Area Changes.

D. Add the remaining pipe
For faster placement, draw the pipe directly between the two junctions.

► Activate the Pipe Drawing Tool again, position the mouse pointer on the J2
Pump, then press and hold the left mouse button. Stretch the pipe across to the
J3 Reservoir, and then release the mouse button. Your model should now look
similar to Figure 2.9.
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Figure 2.9 Pump Sizing model with pipes and junctions placed

At this point all the objects in the model are graphically connected. Save the
model again.

Note: Some users find it desirable to lock objects to the Workspace once placed.
This prevents accidental movement and disruption of the connections. You can
lock all the objects by first selecting all objects by using CTRL+A or the Edit
menu by clicking Select All. Then use CTRL+L or go to the Arrange menu and
selecting Lock Object. The lock button on the Workspace Toolbar will appear
depressed, indicating it is in an enabled state. Alternatively, you can use the grid
feature and snap to grid. The grid options can be modified through the Arrange
menu or User Options window.

Step 3. Specify Analysis Setup

The Analysis Setup window allows the user to define fluid properties, view
undefined pipe/junction properties, adjust solution control, enable Add-on
Modules if purchased and available on the current license, and specify other
simulation settings from a single central location.

► Click Analysis Setup on the Common Toolbar. This opens the Analysis Setup
window (see Figure 2.10). The Analysis Setup window contains various groups
depending on which Add-on Modules you may be using. Each group has one or
more items. A fully defined group has every item within it defined with all
required inputs. Complete every group to run the Solver. A group or item that
needs more information will have a red exclamation point to the left of the
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group or item name. After completing a group, the group icon shows a green
circle with a checkmark. After defining all groups, thus completing the Analysis
Setup, the Model Status light in the lower-right corner turns from red to green.

A. Modules
Under the Modules group, click on the Modules item to open the Modules panel,
shown in Figure 2.10. Here you can enable and disable Add-on Modules if they
are available on the license. These Add-on Modules include Goal Seek &
Control (GSC), Settling Slurry (SSL), Extended Time Simulation (XTS), and
Automated Network Sizing (ANS). By default, the model will have all modules
disabled. Make no changes to this panel for this example.

Figure 2.10 On the Modules panel, you can enable or disable any module

B. Fluid Properties
The Fluid Properties group consists of several items: Fluid, Viscosity Model,
Heat Transfer/Variable Fluids, and Laminar and Non-Newtonian Corrections.
On the Fluid panel, you specify the fluid used in the model. On the Viscosity
Model panel, you can select which viscosity model to use – Newtonian by
default. On the Heat Transfer/Variable Fluids panel, you can specify constant
fluid properties (default selection), variable fluid properties, or single or multiple
fluid heat transfer with energy balance. Finally, on the Laminar and Non-
Newtonian Corrections panel, you can specify the type of corrections to apply
with laminar flow or Non-Newtonian fluids.

By default, only the Fluid panel requires input. Click on the Fluid item to open
the Fluid panel, shown in Figure 2.11. You can directly enter density and
viscosity data (using User Specified Fluid), select a fluid from the Fathom
Standard fluid library, or select Water Data from ASME Steam/Water Tables.
Additionally, you can select from fluids and/or create mixtures using the NIST
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REFPROP library (included in Fathom) or the Chempak library (an optional
add-on to Fathom). You can also add your own custom fluids to the User
Library.

Figure 2.11 Specify the fluid in the model on the Fluid panel

► Select Fathom Standard to see the available fluids (see Figure 2.12). Select
Water (liquid) in the library list, then click the Add to Model button below the
list. On the right, enter a temperature of 21 deg. C. This satisfies the required
inputs for the Fluid panel and Fluid Properties group.

Figure 2.12 The fully defined Fluid panel
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C. Pipes and Junctions
The Pipes and Junctions group is less straightforward to define compared to the
previous two. This group requires full definition for all pipe and junction
properties. Click on the Pipes and Junctions item to open the panel shown in
Figure 2.13. Here, you will see all the undefined pipes and junctions. By
selecting a pipe or junction in the top or middle section, the remaining properties
that need definition appear in the bottom section. Select Pipe 1 for example.
Pipe Length, Pipe Inner Diameter, and Roughness/Friction are undefined. To
define these parameters, you can double-click on Pipe 1 from the top section, or
go to the Workspace and open the properties window from there (double-
clicking the pipe object). However, before closing the Analysis Setup window,
take a look at the final four groups.

Figure 2.13 The Pipes and Junctions panel lists the remaining undefined
objects before the model can run
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D. View the final four groups
The remaining groups are Steady Solution Control, Environmental Properties,
Cost Settings, and Miscellaneous. In the Steady Solution Control group, you can
adjust the tolerance and iteration settings for the Solver; however, the default
settings will suffice for the vast majority of use cases, and caution should be
taken if editing these settings. On the Environmental Properties panel, you can
adjust the ambient pressure, gravitational acceleration, and transition Reynolds
Numbers. The Cost Settings panel allows you to select which costs to include as
well as define energy costs. The Miscellaneous group has items to turn on
NFPA, specify heat transfer sectioning, as well as change other advanced
parameters. The default selections for all four of these groups will suffice to
fully define these panels.

► Click OK to accept the changes in Analysis Setup and to return to the
Workspace. The remaining undefined Pipes and Junctions group requires input
before the model can run. Complete this item by opening the properties window
of the objects directly from the Workspace.

Step 4. Define the pipes and junctions

Check an object’s status to see if a pipe or junction has all the required input.

Object status
Every pipe and junction has an object status. The object status tells you whether
the object has all the necessary inputs. To see the status of the objects in your
model, click the light bulb icon on the Workspace Toolbar (alternatively, you
could choose Show Object Status from the View menu). Each time you click the
light bulb, Show Object Status toggles on or off.

With Show Object Status on, the ID numbers for all undefined pipes and
junctions display in red on the Workspace. Completely defined objects have
their ID numbers displayed in black. These colors are configurable through User
Options from the Tools menu.

Because you have not yet defined the pipes and junctions in this example
problem, all the object ID numbers will change to red when you turn on Show
Object Status.

Showing undefined objects
Additionally, you can see which remaining objects need input in the Undefined
Objects list, similar to what was shown in the Pipes and Junctions panel of the
Analysis Setup.

Open the Undefined Objects list (Figure 2.14) using the List Undefined Objects
button on the Workspace Toolbar or from the View menu by clicking on List
Undefined Objects. The icon on the Workspace Toolbar is located at the far
right end next to the Show Object Status lightbulb icon. This list shows all
objects with incomplete information. Clicking on an undefined pipe or junction
will display the missing property data. Click the Close button (black X icon) on
the bottom-right to stop showing this window.
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Figure 2.14 The List Undefined Objects window lets you see the
undefined properties for each undefined object

A. Define the J1 Reservoir
► To define the first reservoir, open the J1 Reservoir Properties window (Figure

2.15) by double-clicking on the J1 icon. The pipe table should show you that
Pipe 1 connects to this reservoir (click the Pipe Depth & Loss Coefficients tab to
display the pipe table).

Note: You can also open an object’s Properties window by selecting the object
(clicking on it) and then either pressing the Enter key or clicking the Open
Pipe/Junction Window icon on the Workspace Toolbar.

► On the Reservoir Model tab, enter a Liquid Surface Pressure of 0 barG (0
kPa (g)), Pipe Depth of 3 meters, and a Liquid Surface Elevation of 3
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meters. This reservoir will represent the supply reservoir upstream of the pump.
You can assign any unit of pressure or elevation found in the adjacent dropdown
list of units. For this example, keep the units as specified above.

Figure 2.15 Properties window for the J1 Reservoir

Note: You can choose default units for many parameters (such as meters for
length) in the User Options window under Preferred Units.

You can give the junction a name, if desired, by entering it in the Name field at
the top of the window. By default, the junction's name is not specified. If a
junction name is entered, it will be displayed in the Model Data, Output, and in
Workspace Layers. Name this reservoir Lower Reservoir, as shown in Figure
2.15.

You can add most junction types into a custom library. This saves the junction
inputs for repetitive use within the current model, a completely separate model,
or with another user. To select a junction from the custom library, choose the
desired junction from the Library Jct list in the junction's property window. The
current junction will get the properties from the library.

The Copy Data From Jct list at the top of the properties window shows all the
junctions of the same type in the model. This copies the user-selected parameters
from an existing junction in the model to the current junction.

Using the tabs in the properties windows
Separate tabs in the Properties windows contain the junction information and
input fields. Click any tab to bring its information forward. Figure 2.15 shows a
Reservoir junction Properties window.
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With only one pipe connected to the reservoir, enter the depth directly on the
diagram on the Reservoir Model tab. Alternatively, enter the depth, regardless of
the number of pipes, on the Pipe Depth & Loss Coefficients tab (also called the
pipe table). The pipe table allows you to specify entrance and exit loss factors
for each pipe connected to the reservoir (only one in this case). Fathom defaults
to lossless entrance and exits.

► Confirm the pipe depth of 3 meters in the pipe table.

The Optional tab allows you to enter different types of optional data. Depending
on the junction type, you can enter initial guesses for the Solver, specify Design
Factors, set Special Conditions (like closing a valve or turning off a pump), and
change the junction icon.

Each junction has a tab for notes to enter text describing the junction or
documenting any assumptions.

The highlight feature (on by default) displays all the required information in the
Properties window in light blue. You can toggle the highlight on and off by
pressing F2 with the properties window open or by double-clicking an empty
area above the tabs of the properties window. The highlight feature can also be
toggled on and off using the View menu, Highlight in Pipe and Jct Windows
option.

► Click OK to close the Reservoir Properties window. With Show Object Status
turned on, you should see the J1 ID number and name turn black again,
informing you that the junction is fully defined.

The Inspection feature
You can check the input parameters for J1 quickly, in read-only fashion, by
using the Inspection feature. Position the mouse pointer on the J1 Reservoir icon
and hold down the right mouse button. The inspection window appears, as
shown in Figure 2.16.

Inspecting is a faster way of examining the input (and output if results are
available) than opening the Properties window.
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Figure 2.16 Inspect junction properties from the Workspace by clicking
and holding the right mouse button

B. Define other junctions
► Next, open the Properties window for the J2 Pump junction. Remember this

example sizes a centrifugal pump. By default, the junction assumes a Centrifugal
(Rotodynamic) pump, so select Sizing for the Analysis Type. For the Pump
Sizing Parameter, use Volumetric Flow Rate, and enter the Fixed Flow Rate as
115 m3/hr. Set the junction Inlet Elevation as 0 meters (see Figure 2.17). Click
OK to close the window.
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Figure 2.17 Properties window for the J2 Pump

► Open the J3 Reservoir junction and change the name to Upper Reservoir.
Then enter a Liquid Surface Pressure of 0 barG (0 kPa (g)), a Liquid Surface
Elevation of 60 meters, and a Pipe Depth of 3 meters. Click OK.

► Save the model again before proceeding.

C. Define Pipe P1
You can enter data for pipes and junctions in any order. In this example, we
defined the junctions first. Next, define all the pipes. To open the Pipe Properties
window, double-click the pipe on the Workspace.

► First, open the Pipe Properties window for Pipe P1. The Pipe Properties
window offers control over all important hydraulic parameters that are related to
pipes. For Pipe P1, click the dropdown arrow for Pipe Material to select Steel -
ANSI. Next, for Size, select 4 inch (10.2 cm ID), and for Type select STD
(schedule 40). For the Friction Model Data Set, select Standard. Finally, enter a
length of 3 meters (see Figure 2.18) and click OK.
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Figure 2.18 Properties window for Pipe P1

The Inspect feature capability expands to within the Properties window of each
pipe (and certain junctions). Use this when you want to quickly check the
properties of objects that connect to a pipe or junction whose Properties window
you already have open.

To Inspect a junction connected to a given pipe, position the mouse pointer on
the connected junction’s ID number in that pipe’s Properties window (located at
the top right of the Pipe Properties window) and hold down the right mouse
button. This process can be repeated for any junction that states the upstream
and downstream pipe in the junction’s Properties window. You can jump to that
junction’s Properties window by double-clicking the connected junction’s ID
number, or use the Jump button to jump to any other part of the model.

D. Define Pipe P2
► Open the Properties window for Pipe P2 and select Steel - ANSI, 4 inch, STD

(schedule 40), Standard friction model, and enter 300 meters in length. Note that
some of these fields already have values populated based on the input you
entered from Pipe P1.

This pipe has elbows and fittings to specify. For simplicity, represent these as a
total K Factor of 25. Enter this on the Fittings & Losses tab in the Total K
Factor field (Figure 2.19). Click OK to save your changes.

Note: A red ampersand symbol (&) will now appear next to the pipe number for
Pipe P2. This indicates the pipe has Fittings & Losses entered. If desired, the
symbol can be hidden via Workspace Layers. Furthermore, the symbols can be
edited or disabled from the User Options.
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Figure 2.19 Losses in pipes due to fittings are entered on the Fittings &
Losses tab in the Pipe Properties Window

E. Check pipes and junctions
► Check for any remaining undefined pipes or junctions. If all the panels in the

Analysis Setup have their required inputs, the Status Light on the Quick Access
Panel will be green. If not, view the Undefined Objects list from the Analysis
Setup, or turn on Show Object Status from the View menu, and open each
undefined pipe and junction. The Status tab on each Properties window will
indicate the missing information.

F. Review Model Data
► Before running the model, save it one more time. Review the input using the

Model Data window.

Navigate to the Model Data window shown in Figure 2.20 by clicking on the
Model Data tab or pressing CTRL+M. The Model Data window gives you a
table-based perspective of your model. Selections can be copied to the clipboard
and transferred into other Windows programs, saved to a formatted file, printed
to a PDF, or printed out for review.

Data displays in three sections: the General Data section at the top, the Pipe
Data section in the middle, and the Junction Data section at the bottom. Each
section collapses using the buttons at the top-left of the section. Further, each
section can be resized.

The Model Data window allows access to all Properties windows by double-
clicking on any input parameter cell in the row of the pipe or junction you want
to access.
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Figure 2.20 The Model Data window shows all input in table form

Step 5. Run the model
► Run the Model: click the green arrow icon on the Common Toolbar, press

CTRL+R, or open the Analysis menu and click Run Model. During execution,
the Solution Progress window is displayed and can be used to pause or cancel
the Solver's activity (see Figure 2.21). When the solver finishes, click the Output
button and the table-based Output window will appear (see Figure 2.23). Besides
just viewing the results in the Output window, you can save to file, export to
Excel or a spreadsheet-ready format, copy to the clipboard, print to PDF, or print
out on the printer.
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Figure 2.21 The Solution Progress window displays the Solver's
convergence progress

The output file
When the Solver runs, the output data is written to a file. This file is given the
same name as the model itself with a number appended to the name, and with an
*.out extension appended to the end. For all data processing, graphing, etc., the
data is extracted from this file. The number is appended because users are able
to build different scenarios all within this model. Each scenario will have its
own output file; thus, the files need to be distinguishable from each other.

The output file will only remain on disk if you save the model after it has
been run. Once saved, it will remain until the user erases it or the model input
data is modified.

► Save the model file again such that the output file is saved to the disk. This
means that if you were to close your model right now and then reopen it, you
could proceed directly to the Output window for data review without rerunning
your model.

Step 6. Customize the output

Select the specific output parameters and units that you want in your output
report using the Output Control window (Figure 2.22).

► Select Output Control from the Common Toolbar or Tools menu to open the
Output Control window. On the Display Parameters tab, Pipes output type, the
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right-hand side lists the pipe output parameters to display in the output.

Click the General tab, enter the title Water Transfer System, then click OK to
save the title.

If you do not change any of the Output Control settings, the output uses the
default Output Control parameters and title.

Figure 2.22 Customize the output using the Output Control window

Step 7. Review the output

Similar to the Model Data window, the Output window (Figure 2.23) has a
similar structure with three sections. You can expand or collapse each section by
dragging the boundary between the sections up or down or by clicking the arrow
beside the section label. The parameters and units chosen in the Output Control
display in the tables.
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Figure 2.23 The Output window displays output in tabular form

With pumps in the model, Fathom gathers important pump output together in
one convenient location in the Output window on the Pump Summary tab. Go to
this tab located in the General Output section of the Output window, as shown in
Figure 2.24.

The Pump Summary shows that the pump needs to generate 116.3 meters of
head. The minimum required head rise equals the 57-meter elevation difference
of the reservoirs regardless of the flow rate or pipe size. This leaves
approximately 59 meters of friction loss through the pipes. The dH column on
the Pump Summary tab of the Pipe output window shows this output.

The Pump Results Diagram shows the Pump Summary output in diagram form,
as shown in Figure 2.25. Select the "…" button next to Show in the Results
Diagram column, double-click anywhere in the row, or right-click anywhere in
the row and select Pump Results Diagram to view the diagram.

Figure 2.24 The Output window displays the Pump Summary tab when a
model has pumps in it
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Figure 2.25 Pump Results Diagram as opened from the Pump Summary
(see Figure 2.24)

A. Modify the output format
The Output Control window allows you to obtain the parameters, units, and
display order you prefer in your output. This flexibility will help you work with
Fathom in the way that is most meaningful to you, reducing the possibility of
errors.

By default, the Pipe Results table in the output shows the volumetric flow rate in
the second column with units of m3/hr. Next, we will modify the units and order
of parameters shown in the output.

► Select Output Control from the Common Toolbar or from the Tools menu to
open the Output Control Window (see Figure 2.22). On the Display Parameters
tab, Pipes output type, the right-hand side lists the pipe output parameters to
display in the output. Change the units for Volumetric Flow Rate by selecting
the dropdown arrow next to m3/hr, then selecting m3/sec (cubic meters per
second) from the unit list.

► Click OK to display changes to the current results. You should see the
volumetric flow rate pipe results section, still in the second column, in units of
m3/sec. Notice the Velocity results in the third column.
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► Select Output Control from the Common Toolbar again. On the Display
Parameters tab, Pipes output type, the Reorder scroll bar on the far right allows
you to reorder parameters in the list. You can also click on the reorder symbol
on the left side of each row to manually drag-and-drop the rows to change the
parameter order (see Figure 2.22).

► Select the Velocity parameter and use the Reorder scroll bar or drag-and-drop
to move it up to the top of the parameter list.

► Click OK to display the changes to the current results. The first column of
the Pipe Results table now displays Velocity, the second displays Pipe Name,
and the third displays Volumetric Flow Rate.

► Select Output Control from the Common Toolbar one more time. On the
Display Parameters tab, Pipes output type, select Volumetric Flow Rate from the
list on the left. Click the Add button to add it to the list on the right and make
sure its units are m3/hr. Then use the reorder button or row drag-and-drop to
move it below the previous Volumetric Flow Rate parameter.

► Click OK to display the changes to the current results. You will see two
columns of Volumetric Flow Rate, each with different units. This is helpful
when you want to see an output parameter in different sets of units
simultaneously.

► Lastly, double-click the column header for Velocity on the Output window
Pipe Results Table. This opens a window to change the units of the column
without opening the Output Control window (see Figure 2.26). These changes
are automatically updated in the Output Control window. Keep the selected units
as is, and click OK to close the window.

Figure 2.26 Open the Change Units window from the Output window
tables by double-clicking the column header
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B. View the Workspace Layers
Workspace Layers can display input and output data values superimposed over
the graphical model layout. They can also overlay additional graphical
modifications, animations, and customize the appearance of objects in the
model. The displayed data can be organized on one or more layers which can be
toggled on or off, allowing flexibility for viewing results in a graphical manner.

► Navigate to the Workspace window by clicking on the Workspace tab or
pressing CTRL+W. Select the Workspace Layers tab in the bottom-right of the
Quick Access Panel. The Workspace Layers panel contains two sections named
Layer Presets and Layers.

Within the Layers section, there are two layer groups named Advanced Layers
and Standard. We will integrate the model results with the graphical layout of
the pipe network by using a Standard layer. All models must have at least one
Standard layer, so by default there will be a "Layer 1" automatically created. It
will contain all objects in the model (pipes, junctions, annotations, etc);
however, objects can be hidden if desired, or the visibility of the entire layer
itself can be toggled on/off using the eye icon next to the layer. When additional
layers are created they will stack on top of each other, with the layers on top
taking precedence over others below. The combination of layers and toggling
visibility allows for a wide range of visual customization.

► Open the Layer Settings window for Layer 1 by double-clicking the layer.
The Layer Settings window is shown in Figure 2.27.

The Layer Settings window provides flexible options for customizing the
appearance of the model. The Pipes & Junctions group allows you to show or
hide junctions, and change display properties like color, size, and thickness. The
Label Control group allows you to display input and output parameters next to
objects on the Workspace. The Annotations group allows you to customize
annotations.
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Figure 2.27 The Layer Settings window specifies content to be
superimposed on the Workspace

► Select the Pipe Parameters item under the Label Control group. The left
pane lists input and output parameters available for display, and the right pane
lists the parameters currently being displayed by the layer on the Workspace.

► In the left pane, expand the Pipe Parameters list. Then, scroll to the bottom
of the list and select the Volumetric Flow Rate parameter. Add it to the right
pane by either double-clicking the parameter, or selecting the parameter and
clicking the arrow between the panes. Set the units to m3/hr.

► Select the Junction Parameters item under the Label Control Group.
Expand the Junction Parameters list and add the Pressure Static Inlet parameter
with units of barG. Expand the Pump Summary Parameters list and add the
Head Rise parameter with units of meters. Close the Layer Settings using the
button in the bottom-right.

► Add additional clarity by repositioning the labels and adding a legend. It is
common for the text on the Workspace Layers to overlap with objects when first
generated. Labels can be dragged to a new area or a smaller font can be selected
using the Font Decrease icon on the Workspace Toolbar or from within the
Global Layer Settings. Parameter units can be consolidated in a legend which
can be added via the Global Layer Settings. In the Layers Toolbar, click the
double gear icon to open the Global Layer Settings. Then, enable the checkbox
for Show Units in Legend. The result of these adjustments is shown in Figure
2.28.
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Figure 2.28 Results are superimposed on the model layout via Workspace
Layers

C. Graph the results
► Navigate to the Graph Results window by clicking on the Graph Results tab

or pressing CTRL+G. The Graph Results window offers versatile graph
generation and preparation.

Fathom's Graph Guide, accessed by clicking on the What Would You Like to
Do? button located at the top-right of the Graph area, provides assistance by
guiding you through the creation of a Quick and Simple graph, or an Advanced
graph (Figure 2.29). You can create a graph by following the prompts on the
Graph Guide, by manually specifying the graphing parameters on the Graph
Control tab on the Quick Access Panel, or from the Select Graph Parameters
icon located in the top-left corner of the Graph Results toolbar. For the
remainder of this Quick Start Guide, the Graph Guide will be hidden, but keep
in mind that you can use it whenever you would like assistance in creating a
graph.

Figure 2.30 shows the Graph Results window with the Graph Control tab
enabled on the Quick Access Panel.
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Figure 2.29 The Graph Guide can be toggled on and off by clicking the
What Would You Like to Do? button on the Graph Results
window

Figure 2.30 The Graph Results window is where various system
parameters can be graphed

Fathom gives you the ability to create stacked graphs. These are graphs that are
displayed on top of each other with the same x-axis but with different
parameters on the y-axis. This feature helps show the output of multiple
parameters in the same location of your model simultaneously without creating
completely separate graphs.

► Click the Profile tab on the Parameters pane. In the Pipes selection list, click
the All button to select all the pipes.

► For the Length Units, keep the default units of meters.

► From the Parameters definition area, keep Pressure Static selected and
select units of bar.

► To add a stacked graph, click the Add button with the green “+” icon next to
Select Parameter, shown in Figure 2.31. A new row under the Parameters
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definition area will appear.
► Choose Volumetric Flow Rate in this new parameter row, and keep the

default units of m3/hr.
► Click Generate to create the stacked static pressure and volumetric flow rate

graphs, shown in Figure 2.32. Note that the pump adds approximately 12 bar of
pressure in order to maintain a flow of 115 m3/hr throughout the pipeline.

► To format the legend font size, right-click on a legend and use the slider bar to
decrease the font size to 12 for both graphs. Drag the static pressure graph
legend to the upper-right corner of the graph to improve visibility of the graphed
data.

► To format each axis font size, right-click on each axis title and use the slider
bar to decrease the size until the font size on each axis appears as you like.

► To format axis boundaries, right-click on the axis title or numbers and uncheck
Auto Scale. Adjust Minimum and Maximum values as necessary

Figure 2.31 The Graph Control tab on the Quick Access Panel allows you
to specify the graph parameters you want to graph in the
Parameters/Formatting area

The Formatting area on the Graph Control tab can be used to modify the graph
colors, fonts, and other elements. Options to copy the graph image or x-y data
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are available on the Graph Results Toolbar or by right-clicking the graph. The
graph image or x-y data can be saved from the File menu.

Figure 2.32 The Graph Results window showing a graph of the static
pressure and volumetric flow rate along the entire length of
the pipeline

Step 8. Add a pump curve

With the known pump head requirement of 116.3 meters at the design flow rate
of 115 m3/hr, you can purchase a pump of the correct size to meet this
requirement. With the actual pump curve, add the pump characteristics to the
junction.

Open the J2 Pump Properties window. Change the Analysis Type from Sizing to
Pump Curve. Then select the Enter Curve Data button. This will open the Pump
Configuration window.

Enter the following pump curve data, as shown in Figure 2.33, in the Raw Data
table. After the data has been entered, click Generate Curve Fit Now to fit a
curve to the data. Then, click the OK button to close the Pump Configuration
window, then the OK button again to close the Pump Properties window. If
prompted, click OK to acknowledge that any previous output data will be
erased.
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Q (m3/hr) dH (meters)

0 122

115 116

230 76

Figure 2.33 Enter the pump curve data in the Pump Configuration window

Note: In this situation a user could create a new scenario using the Scenario
Manager to examine a what-if situation, without disturbing the basic model. See
Chapter 4 for an example that illustrates how to use the Scenario Manager.

Re-run the model. Examine the Pump Summary in the General Output Section.
The output (Figure 2.34) shows the pump operating at a flow rate of 114.7
m3/hr and a head rise of 116.1 meters which is acceptably close to the previous
sizing calculation.

Navigate to the Graph Results window and to the Pump vs. System tab on the
Parameters pane of the Quick Access Panel (Figure 2.35). Generate a pump vs.
system curve using the default selection as shown in Figure 2.36.
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Figure 2.34 Output using a pump with a pump curve

Figure 2.35 The Graph Control tab on the Quick Access Panel can
generate a Pump vs. System Curve
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Figure 2.36 Pump Curve vs. System Curve for Pump 2

Conclusion

You have now used Fathom's Primary Windows to build and analyze a simple
model, and to size a pump.
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C H A P T E R 3

Spray Discharge System Example

This example demonstrates how to find the minimum supply pressure needed to
provide a system of eight spray discharge heads with at least 25 m3/hr to each
spray head.

Topics covered
� Using spray discharge junctions

� Using the Global Pipe Edit and Copy Junction Data From tools

� Using manual iterative techniques to arrive at a desired result

� Using the Isometric Pipe Drawing Mode

Required knowledge

This example assumes that the user has some familiarity with Fathom such as
placing junctions, connecting pipes, and entering pipe and junction properties.
Refer to the example in Chapter 2 for more information on these topics.

Model file

A completed version of the model file can be referenced from the Examples
folder as part of the Fathom installation:

C:\Users\[username]\Documents\Datacor\Fathom 14\Examples
� Metric - Spray Discharge System.fth

Problem statement

A constant pressure source supplies a spray discharge system consisting of eight
spray discharge nozzles. The system has one main supply line that branches into
two supply lines that supply four sprays on each side. Determine the minimum
supply pressure necessary to ensure a minimum volumetric flow rate of 25
m3/hr through each of the spray junctions.
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Step 1. Specify fluid properties
1. Open Analysis Setup from the Common Toolbar or from the Analysis

menu.
2. Under the Fluid Properties group, click the Fluid item to open the Fluid

panel. Select the Fathom Standard fluid library and then select Water
(liquid) in the Fluids Available in Library list.

3. Click Add to Model to select water for use in this model.

4. Enter 21 deg. C for the temperature. The fluid properties will be
automatically calculated.

5. The Fluid panel should resemble Figure 3.1. Click OK.

Figure 3.1 Fully specified fluid panel in the Analysis Setup

Step 2. Build the model

A. Place the pipes and junctions
This completes the first two groups of the Analysis Setup. The Pipes and
Junctions group remains undefined. To complete this group, begin by
assembling the model on the Workspace as shown in Figure 3.2.

Note: Multiple of the same junction type (or pipes) can be quickly placed by
double-clicking that junction's icon in the Toolbox, then clicking consecutively
on the Workspace to place the junctions. When finished, press the ESC key to
exit the multiple object drawing mode. This is useful for placing multiple Spray
Discharge junctions for this model, and for drawing many pipes rapidly.

41 Fathom 14 Quick Start Guide



Figure 3.2 Layout of the pipe system for the Spray Discharge System
Example

B. Define the pipes
With the objects in place, define the input data for the pipes and junctions.
Double-click Pipes P1-P3 and enter the following inputs in the Properties
window (use Global Edit, addressed below, for Pipes P4-P11).

For all pipes, use Pipe Material = Steel - ANSI, Type = STD (schedule 40),
Friction Model = Standard, and the following parameters:

Pipe Size (inch) Length (meters)

P1 8 150

P2 8 150

P3 4 3

P4 1-1/2 3

P5 1-1/2 3

P6 1-1/2 3

P7 1-1/2 3

P8 1-1/2 3

P9 1-1/2 3

P10 1-1/2 3

P11 1-1/2 3
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Use Global Pipe Edit to quickly define identical pipes such as P4-P11. Global
Pipe Edit applies changes to multiple pipes at the same time. Select Global Pipe
Edit from the Workspace Toolbar or Edit menu. The Global Pipe Edit window
opens. Click the All button above the list, then deselect Pipes P1-P3, such that
only Pipes P4-P11 have the checkboxes enabled, as shown in Figure 3.3.

Figure 3.3 Global Pipe Edit for the Spray Discharge System Example

After selecting the pipes, click the Select Pipe Data button. A template Pipe
Properties window opens to input the pipe information that will apply to all of
the selected pipes. Fill out the properties window according to the previous table
for Pipes P4-P11. After entering all of the parameters, close the Pipe Properties
window by selecting OK. The Global Pipe Edit window now displays a list of
all possible parameters to apply to the selected pipes. The parameter categories
in the list match the tabs on the Pipe Properties window. For this example, you
want all of the parameters to apply to the selected pipes. To do this, click the All
button above the list of parameters or the check box beside each parameter. The
Global Pipe Edit window now appears as shown in Figure 3.4.
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Figure 3.4 Global Pipe Edit for the Spray Discharge System Example
with all pipe parameters selected for updates

Apply the changes to the selected pipes by clicking the Apply Selections button.
Fathom will notify you that the changes were successfully applied with a
message in the bottom-left of the Global Pipe Edit window. If you wish to
cancel all of the changes you applied, click Cancel on the Global Pipe Edit
window. Otherwise, accept the changes by clicking OK.

Note: The Guide button in the Global Edit windows may be used as a reminder
of the required steps for the global edit process if needed.

C. Define the spray discharge junctions
All of the spray discharge junctions have the same input. Use the Global
Junction Edit tool to define all of the spray discharge junctions at the same time.
The Global Junction Edit tool works in much the same way as the Global Pipe
Edit tool.

Another tool to speed up the time it takes to define objects is the Copy Data
From Junction tool. Define the J1 Spray Discharge junction, as listed below.
1. Elevation = 3 meters

2. Loss Model = Cd Spray (Discharge Coefficient)
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3. Geometry = Spray Nozzle

4. Exit Properties = Pressure

5. Exit Pressure = 0 barG

6. Cd (Discharge Coefficient) = 0.6

7. Discharge Flow Area = 3.5 cm2

After defining J1, click OK to close the properties window, and open the
Properties window for spray discharge J2. Locate the drop-down box near the
top of the properties window labeled Copy Data From Jct. This box lists all of
the spray discharge junctions on the Workspace. Select Junction 1 from the list.
This will open the Copy Data From Junction 1 window, which, similar to the
Global Edit window, lists all parameters for J1. Check the box beside a
parameter to apply the parameter value to J2. In this case, you want all of the
parameters for junction J1 to apply to J2, so select the All button at the top of
the list to select all of the parameters, as shown in Figure 3.5.

Figure 3.5 Copy Data from Junction window used for the Copy Data from
Junction tool

After clicking the OK button in the Copy Data From Junction window, all of the
J2 parameters are updated to the selected J1 parameter values. Repeat this
process for all of the spray discharge junctions, or utilize the Global Edit feature.

There is a similar function available from the Pipe Properties window tool.
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D. Enter other junction data

J9 - Assigned Pressure
1. Elevation = 0.3 meters

2. Pressure Specification = Stagnation

3. Pressure = 14 barG (1400 kPa (g))

J10 - Branch
Elevation = 3 meters

J11 - Branch
Elevation = 0.3 meters

J12 - Dead End
Elevation = 0.3 meters

E. Check if the pipe and junction data is complete
Check the Model Status light in the bottom-right of the Quick Access Panel. A
green light at this point indicates a fully defined model. A red light indicates that
there are undefined pipes or junctions in the model. If this happens, go back to
the incomplete pipes or junctions and enter the missing parameters.
Alternatively, open the List Undefined Objects window from the View menu to
see the undefined objects.

Step 3. Run the model

Click Run Model from the Common Toolbar or Analysis menu. The Solution
Progress window opens and begins iterating. This window displays the Fathom
Solver converging on the answer. After the solver converges, view the results by
clicking Output at the bottom of the Solution Progress window.

Open the Output Control from the Common Toolbar or Tools menu and select
the Junctions output type. Add the Vol. Flow Rate Net at Junction parameter by
double-clicking the parameter name in the list on the left, then clicking OK. In
this example, the net volumetric flow rate represents the flow rate exiting the
nozzle to the ambient surroundings.
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Figure 3.6 Output Window for the Spray Discharge System Example

The Output window contains all the results specified in the Output Control
window. The output for this example, shown in Figure 3.6, displays a supply
pressure of 14 barG, stagnation, for the inlet of Pipe P1. The last column on the
Spray Discharge tab of the junction output table shows a volumetric flow rate
above 25 m3/hr for all of the spray discharge junctions.

Reduce the supply pressure and run the model again. Repeat this process until
you have determined the minimum supply pressure required to supply 25 m3/hr
at every spray junction.

Step 4. Graph the results

Fathom can create dual y-axis graphs, which plot two parameters on the same
graph with the same x-axis. You will need to decide what parameter you wish to
plot on the primary y-axis and which parameter you want to plot on the
secondary y-axis. In this example, we will plot static pressure on the primary y-
axis and volumetric flow rate on the secondary y-axis.

Graph the static pressure and volumetric flow rate from the constant pressure
supply J9 through spray nozzle J1 on a dual y-axis graph to graphically
determine whether the minimum flow through each spray nozzle is at least 25
m3/hr.

47 Fathom 14 Quick Start Guide



Note: You can repeat this process for the flow path from the constant pressure
junction J9 to spray nozzle J8, or you can graph both flow paths on this same
graph using the Plot Multiple Paths Using Groups feature.

1. Navigate to the Graph Results tab. On the Quick Access Panel, Graph
Control tab, use the default selection of Plot Single Path. In the Pipes
definition area, select pipes 1, 3, 4, 5, 6, and 7. These pipes make up the
path from the constant pressure supply J9 to the J1 spray nozzle. Select
these pipes quickly by first selecting them in the Workspace (using Ctrl +
left-click), then clicking the Workspace button on the Graph Control tab.

2. Use meters as the Length Units.

3. Use Pressure Static for the parameter with barG as the unit.

4. Add a parameter by clicking the Add button next to Select Parameter in the
Parameters definition area.

5. Change this added parameter to Volumetric Flow Rate and choose m3/hr as
the unit.

6. To set the volumetric flow rate on the secondary y-axis, click the Make
Secondary Y-Axis button, the blue arrow icon pointing right located above
the selected parameters. Alternatively, double-click on the thin column in
front of Volumetric Flow Rate in the Parameter definition area. Note that
Volumetric Flow Rate becomes indented under Pressure Static, and that the
black arrow next to Volumetric Flow Rate turns to point to the left. See
Figure 3.7 to see how these graphing parameters are defined.
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Figure 3.7 Parameter definition for a dual y-axis graph of static pressure
(primary y-axis) and volumetric flow rate (secondary y-axis)
on the Graph Control tab on the Quick Access Panel

Click the Generate button. After the graph generates, note that the static pressure
and volumetric flow rate drop, as expected, when some flow leaves the system
through each spray nozzle. See the graph in Figure 3.8.

Figure 3.8 Pressure and volumetric flow rate from the constant pressure
supply (J9) to the spray nozzle at one end of the model (J1)
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Analysis summary

The minimum required supply pressure necessary to supply a volumetric flow
rate of 25 m3/hr to all of the spray junctions is about 13.2 barG, stagnation.

By iterating on values for the supply pressure, you used Fathom to determine the
minimum required supply pressure for this system. This information can be used
to design the supply reservoir for this system.

The goal seeking capabilities in the optional Fathom GSC Add-on Module
eliminate the manual iteration required for this problem. With the supply
pressure set as a variable and the minimum flow rate of 25 m3/hr for the spray
discharges set as the goal (this is called a group max/min goal), the Fathom GSC
Module then iterates on the supply pressure until the goal is achieved. This
eliminates the need to run Fathom multiple times to arrive at the final solution.

Chapter 5 provides more information on the Fathom GSC Module.

Isometric Pipe Drawing Mode

Fathom uses a 2D grid by default for objects on the Workspace, as was the case
with this example. Figure 3.9 shows the spray discharge system with the 2D grid
displayed (select Show Grid from the Arrange menu).

Figure 3.9 Spray discharge system with the 2D grid shown

At times it may be convenient to demonstrate the three-dimensional nature of a
system. For example, you may be building a model based on isometric reference
drawings. Fathom includes an Isometric Pipe Drawing Mode for these cases.
The isometric grid has three gridlines that are offset by 60°, representing the x,
y, and z axes. Figure 3.10 shows the spray discharge system built on an
isometric grid.
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Figure 3.10 Spray discharge system with the isometric grid shown

You can enable the isometric grid by going to the Arrange menu from the
Workspace. Under Pipe Drawing Mode, there are three options: 2D Freeform
(default), 2D Orthogonal, and Isometric.

Create the spray discharge system on an isometric grid to see how to use this
feature.
1. Go to the File menu and select New.

2. From the Arrange menu, choose Show Grid.

3. From the Arrange menu again, go to Pipe Drawing Mode and select
Isometric.

4. Place a Spray Discharge junction, J1, on the Workspace. Notice that
placing junctions onto the Workspace follows the usual rules; however, the
visual appearance of the icon is more complex than in a 2D grid. The
preferred icon and rotation must be selected based on the pipe connections.
We will address this later.

5. Double-click the Spray Discharge icon in the Toolbox, then place junctions
J2-J8.

6. Place the assigned pressure junction, J9, on the Workspace.

7. Place two branch junctions, J10 and J11, on the Workspace.

8. Place the dead end junction, J12, on the Workspace.

9. Right click on J12 and select Customize Icon. Notice that you may need to
use the Rotate button to get the preferred icon and rotation, as shown in
Figure 3.11.
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Figure 3.11 Use the Rotate button to obtain the preferred icon and
rotation

10. Draw Pipes P1 and P2 as shown in Figure 3.10.

11. Draw Pipe P3 from J11 to J10. A red-dashed preview line will show how
the pipe will display on the isometric grid. Change the preview line by
clicking any arrow key on your keyboard or scrolling the scroll wheel on
your mouse. Figure 3.12 shows Pipe P3 with the preview line.

Note: You can hold the ALT key while adjusting a pipe by the endpoint to add
an additional segment. This can be used with the arrow key or mouse scroll
wheel to change between different preview line options.

12. Draw Pipes P4-P11 as shown in Figure 3.10.

13. Right-click on junctions J1 and J8 and select Customize Icon. Select the
appropriate orientation, as shown in Figure 3.10.

14. Select all of the remaining Spray Discharge Junctions. Right-click one of
the junctions and select Auto-rotate Icon. The junctions will automatically
align with the connected pipes.

15. Turn the grid off in the Arrange menu as shown in Figure 3.13.
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Figure 3.12 A preview line is shown when drawing or adjusting pipes in
the Isometric Drawing Mode

Figure 3.13 Isometric spray discharge system with the grid not shown
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C H A P T E R 4

Freon Delivery System with Heat Transfer
Example

This example demonstrates how to use heat transfer modeling on pipes and heat
exchangers and using different refrigerant fluids to achieve certain design goals.

Topics covered
� Using the NIST REFPROP library to define fluids

� Setting up a heat transfer model in Analysis Setup

� Specifying convective heat transfer data for pipes

� Specifying thermal characteristics of heat exchangers

� Entering pump curves

� Entering resistance curves

� Using the Scenario Manager

Required knowledge

This example assumes that the user has some familiarity with Fathom such as
placing junctions, connecting pipes, and entering pipe and junction properties.
Refer to the example in Chapter 2 for more information on these topics.

Model file

A completed version of the model file can be referenced from the Examples
folder as part of the Fathom installation:

C:\Users\[username]\Documents\Datacor\Fathom 14\Examples
� Metric - Freon Delivery System with Heat Transfer.fth
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Problem statement

A delivery system supplies Freon at 25 deg. C. Evaluate two candidate
refrigerants (Refrigerant 11 and 123) to determine the best choice. Additionally,
calculate the temperature of the hot water supply needed for the heat exchangers
and select the refrigerant that requires the lowest water temperature.

Step 1. Specify fluid properties
1. Open Analysis Setup by selecting Analysis Setup from the Common

Toolbar or from the Analysis menu.
2. Under the Fluid Properties group, click the Fluid item to open the fluid

panel. Select the NIST REFPROP fluid library, click Search, type R11 in
the search field, click OK, click R11 in the Search Results, then click the
Select button.

3. Click Add to Model to select R11 for use in this model.

4. In the Fluid Properties section on the right, enter 10.5 barG for pressure and
-45 deg. C for temperature (see Figure 4.1). Default fluid properties are
automatically calculated. The Solver adjusts the fluid properties during the
simulation when modeling heat transfer.

5. Navigate to the Heat Transfer/Variable Fluids panel by clicking on the Heat
Transfer/Variable Fluids item on the left under the Fluid Properties group.

6. Select the option for Heat Transfer With Energy Balance (Single Fluid).
This enables Fathom's heat transfer capabilities.

7. Click OK to close Analysis Setup.

55 Fathom 14 Quick Start Guide



Figure 4.1 Fluid panel with R11 selected and fluid pressure and
temperature specified

Step 2. Build the model

A. Place the pipes and junctions
This completes the first two groups of the Analysis Setup. The Pipes and
Junctions group remains undefined. To complete this group, begin by
assembling the model on the Workspace as shown in Figure 4.2. To add
graphical bends for Pipes 3-7, select a pipe, open the Arrange menu, go to
Add/Remove Segments, then click Add Segment. Move the segment point to the
desired location on the Workspace. Alternatively, enable the 2D Orthogonal
Pipe Drawing Mode to automatically draw pipes along an orthogonal grid, or,
after selecting a pipe, press CTRL+SHIFT+Y to add a pipe segment.
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Figure 4.2 Layout of the pipe system for the Freon Delivery System with
Heat Transfer Example

B. Define the pipes
With the objects in place, define the input data for the pipes and junctions.
Double-click each pipe and enter the following data in the Properties window
(or use the Global Pipe Edit window, as discussed in Chapter 3).

For Pipes P1-P7, use
� Pipe Material = Steel - ANSI

� Size = 3 inch (7.8 cm ID)

� Type = STD (schedule 40)

� Friction Model = Standard

� Length = use the table below

Pipe Length (meters)

P1 3

P2 3

P3 1.5

P4 1.5

P5 1.5
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Pipe Length (meters)

P6 1.5

P7 9

Specify the piping heat transfer parameters on the Heat Transfer tab in the Pipe
Properties window, as shown below for Pipe P1 in Figure 4.3. After entering the
parameters below for Pipe P1, click OK.
1. Heat Transfer Model = Convective Heat Transfer

2. Resistance Geometry = Radial

3. Number of Insulation Layers = 1 External

4. Ambient Conditions:
a. Temperature = 16 deg. C

b. Fluid Velocity = 8 km/hr

c. Fluid = Air

5. Use default values for Fluid Internal, Pipe Wall, and External

6. Insulation #1 (external):
a. Apply = Checked

b. Conductivity/Convection Data Source = User Specified

c. Conductivity (W/m-K) = 0.7

d. Thickness (cm) = 3

e. HT Area Ratio = 1

Figure 4.3 Pipe Heat Transfer tab for the Freon Delivery System Example
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After specifying the piping heat transfer for Pipe P1, open the Global Pipe Edit
window, select the Existing Pipe option under the Choose Data From section at
the top, in the dropdown choose data from Pipe P1, check the box next to Heat
Transfer in the Parameters to Change list, select all pipes in the Pipe List, and
click Apply Selections before clicking OK.

Add an additional loss due to an elbow fitting to Pipes P3-P6. To add this loss,
open the Pipe Properties window, go to the Fittings & Losses tab, and click the
Specify Fittings & Losses button (Figure 4.4). This opens the Pipe Fittings &
Losses window.

Figure 4.4 The Pipe Fittings & Losses window is opened by clicking the
Specify Fitting & Losses button on the Pipe Properties
window

Go to the Bends tab and under Standard Threaded, General, 90 deg. (C), enter a
quantity of 1 (Figure 4.5). Click the OK button to add this loss to the pipe, then
repeat for Pipes P4-P6. Global pipe editing could also be used to make this
change to all four pipes simultaneously.
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Figure 4.5 Add Fittings & Losses to pipes by specifying fitting quantities
on the Pipe Fittings & Losses window

C. Define the junctions

J1 - Reservoir Junction
1. Name = Supply Reservoir

2. Liquid Surface Pressure = 10.5 barG (1050 kPa (g))

3. Pipe Depth = 0 meters

4. Liquid Surface Elevation = 3 meters

5. Liquid Temperature = -45 deg. C

6. Liquid Density = keep default value

J7 - Reservoir Junction
1. Name = Receiving Reservoir

2. Liquid Surface Pressure = 10.5 barG (1050 kPa (g))

3. Pipe Depth = 0 meters

4. Liquid Surface Elevation = 3 meters

5. Liquid Temperature = 24 deg. C

6. Liquid Density = keep default value

J3, J5 - Branch Junctions
1. Elevation = 0.5 meters

60 Fathom 14 Quick Start Guide



J2 - Pump Junction
1. Inlet Elevation = 0.5 meters

2. Pump Model = Centrifugal (Rotodynamic)

3. Analysis Type = Pump Curve

4. Enter the pump curve data (see Figure 4.6):
a. Click Enter Curve Data.

b. Enter the following pump curve data in the Raw Data table:

Volumetric Head

m3/hr meters

0 7.5

45 7

115 4.5

c. Click Generate Curve Fit Now to create the curve fit.

d. Close the Pump Configuration window by clicking OK.
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Figure 4.6 Pump Configuration window for the Freon Delivery
System Example

J4, J6 - Heat Exchangers
1. Inlet Elevation = 0.5 meters

2. Loss Model = Resistance Curve

3. Enter resistance curve data (see Figure 4.7):
a. Click Enter Curve Data.

b. Change the Flow Parameter to Volumetric.

c. Enter 55 m3/hr and 0.15 bar (25 kPa) in the Raw Data table.

d. Click Fill As Quadratic above the data table to create data for a square
law loss curve, which is typical of heat exchangers.

e. Click Generate Curve Fit Now to create a quadratic curve fit.

f. Click OK to save and close.

4. Enter the following data on the Thermal Data tab:
a. Thermal Model = Counter-Flow

b. Heat Transfer Area = 7.5 meters2

c. Overall Heat Transfer Coefficient = 2800 W/m2-K
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d. Secondary Fluid Flow Rate = 15 kg/sec

e. Secondary Fluid Specific Heat = 4.2 kJ/kg-K

f. Secondary Fluid Inlet Temperature = 95 deg. C

Figure 4.7 Heat Exchanger Loss Curve Fit window for the Freon Delivery
System Example

Start with the initial guess of 95 deg. C for the Secondary Fluid Inlet
Temperature. This problem will require manual iteration to achieve the desired
result. You will need to run the model, examine the results, and adjust the
Secondary Fluid Inlet Temperature for both heat exchangers until you achieve
the desired Freon outlet temperature of 24 deg. C.

D. Check if the pipe and junction data is complete
Check the Model Status light in the bottom-right of the Quick Access panel. A
green light at this point indicates a fully defined model. A red light indicates
undefined pipes or junctions in the model. If this happens, go back to the
incomplete pipes or junctions, and enter the missing parameters. Alternatively,
open the List Undefined Objects window from the View menu to see the
undefined objects.

Step 3. Create a scenario for each refrigerant

To determine the best refrigerant that minimizes the temperature of the hot water
used to heat the Freon to the delivery temperature, use the Scenario Manager to
examine the different results for each refrigerant in the system.
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The Scenario Manager is a powerful tool for managing variations of a model,
referred to as scenarios. The Scenario Manager allows you to:
� Create, name, and organize scenarios

� Select the scenario to appear in the Workspace (the current scenario)

� Delete, copy, and rename scenarios

� Duplicate scenarios and save them as separate models

� Review differences between scenarios using the Scenario Comparison Tool

� Propagate changes from a parent scenario to its children

Create two scenarios to model these cases. Access the Scenario Manager from
the Quick Access Panel, which is located on the right side of the Workspace
area, or from the Tools menu. A scenario tree displays all model scenarios.

Click the Create Child button on the Quick Access Panel, or from the right-click
menu on the Base Scenario. Name the child R11. A new scenario will appear
below the Base Scenario. Select the Base Scenario, create another child, and
name it R123. See Figure 4.8.

Figure 4.8 Create model variants and keep them organized using the
Scenario Manager on the Quick Access Panel

Step 4. Set up the R11 case

The Base Scenario contains all of the basic information for the model, such as
the pipe and junction layout, pipe lengths, system properties, etc.

Child scenarios inherit data from their ancestors. As long as the data has not
been modified in a child scenario, parameters in the child scenario will have the
same value as their parent. In this example, you entered R11 as the fluid in the
Analysis Setup window in the Base Scenario, so the R11 scenario has inherited
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the same fluid properties as the Base Scenario. Therefore, make no changes to
the R11 scenario.

Double-click the R11 scenario in the scenario tree of the Scenario Manager on
the Quick Access Panel. This loads the R11 scenario onto the Workspace as the
current scenario. The currently loaded scenario is displayed in the scenario tree
with a green circle and a white check mark (Figure 4.8). Alternatively, you can
use the Scenario Manager window from the Tools menu to load the scenario.

Step 5. Run the R11 case

With the initial guess of 95 deg. C for the secondary fluid inlet temperature,
click Run Model from the Common Toolbar or Analysis menu. The Solution
Progress window opens and begins iterating. This window displays the Fathom
Solver converging on the answer. After the Solver converges, view the results
by clicking Output at the bottom of the Solution Progress window.

Step 6. Examine the R11 results

If the default Output Control parameters are displayed, a warning will state
HGL, EGL and head loss results may not be meaningful for variable density
systems as can be seen in Figure 4.9. Hide all head output parameters to remove
this warning.

Note the R11 delivery temperature of 48.50 deg. C at the outlet of Pipe P7 by
navigating to the Heat Transfer tab in the Pipe output section (Figure 4.9). This
is well above the required maximum delivery temperature of 24 deg. C. The
inlet temperature of the Secondary Fluid must decrease and the model must run
again to determine the outlet temperature at the new value. Modify the
Secondary Fluid Inlet Temperature and repeat this process until the Freon is
delivered to the receiving reservoir at 24 deg. C.
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Figure 4.9 Output for the Freon Delivery System for R11 with a
Secondary Fluid Inlet Temperature of 95 deg. C

Open the Pipe Heat Transfer Results Diagram from the Heat Transfer tab (see
Figure 4.10) by selecting the "..." button next to Show in the Results Diagram
column, double-clicking anywhere in the Pipe 7 row, or right-clicking anywhere
in the row and selecting Pipe Results Diagram.
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Figure 4.10 Pipe Heat Transfer Results Diagram opened from the Heat
Transfer Table (see Figure 4.9)

Step 7. Set up the R123 case

Double-click the R123 scenario in the Scenario Manager to load it as the current
scenario. Then, open Analysis Setup and open the Fluid panel. Similar to Step 2,
search for and select R123, select Yes to remove R11 from the scenario when
prompted, and enter same pressure and temperature as before: 10.5 barG and -45
deg. C.

Step 8. Run the R123 case and examine the results

With the initial guess of 95 deg. C for the secondary fluid inlet temperature,
click Run Model. After the Solver converges, click Output.

Note the R123 delivery temperature of 41.21 deg. C at the outlet of Pipe P7 in
the Heat Transfer tab (see Figure 4.11). This is above the minimum temperature
of 24 deg. C. Iterate again until the Secondary Fluid Inlet Temperature delivers
the Freon at 24 deg. C.
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Figure 4.11 Output for the Freon Delivery System for R123 with a
Secondary Fluid Inlet Temperature of 95 deg. C

Analysis summary

The results of the iterative solutions show the following:

Refrigerant

Secondary
Fluid Inlet

Temp

(deg. C)

R11 57.76

R123 66.44

In terms of heat exchanger hot water temperature, R11 is the better choice for a
refrigerant delivery temperature of 24.00 deg. C. However, consider other
factors, such as environmental regulations, in the selection of a refrigerant.

Similar to the spray system in Chapter 3, this example requires manual iteration
to obtain the results. The goal seeking capabilities in the optional Fathom GSC
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Add-on Module solves this problem directly without manual iteration. Using
both heat exchanger secondary inlet temperatures as the variables (as linked
variables) and the fluid outlet temperature of Pipe P7 as the goal, the Solver can
directly calculate the seconadary fluid inlet temperature.

Chapter 5 contains more discussion on the GSC Add-on Module.
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C H A P T E R 5

Fathom Add-on Modules Examples

This chapter covers two examples. The first example demonstrates how to use
the Goal Seek & Control (GSC) and Extended Time Simulation (XTS) optional
Add-on Modules for Fathom. Later in the chapter, a second example uses the
Settling Slurry (SSL) Add-on Module.

A separate Quick Start Guide covers the Automated Network Sizing (ANS)
module.

The user can only perform these examples if access to the relevant modules is
available.

Topics covered
� GSC - Using the Goal Seek and Control Manager

� GSC - Defining Variables and Goals

� XTS - Specifying the Transient Control group

� XTS - Defining system transients

� XTS - Understanding Transient Output

� SSL - Defining settling slurry properties

Required knowledge

This example assumes that the user has some familiarity with Fathom such as
placing junctions, connecting pipes, and entering pipe and junction properties.
Refer to the example in Chapter 2 for more information on these topics.

To model the heat transfer in the GSC example, refer to Chapter 4 for more
detailed explanations on modeling heat transfer.

Model files

For your reference, see the completed model files for these examples installed in
the Examples folder as part of the Fathom installation:

C:\Users\username\Documents\Datacor\Fathom 14\Examples
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� Metric - Controlled Heat Exchanger Temperature - GSC.fth

� Metric - Controlled Heat Exchanger Temperature - XTS.fth

� Metric - Pump Sizing for Sand Transfer System - SSL.fth

Problem statements

GSC Example
Use the Goal Seek & Control Add-on Module to determine the valve open
percentage required to maintain a 50 deg. C temperature at branch junction J8
for a reservoir supply temperature of 90 deg. C.

XTS Example
Use the Extended Time Simulation Add-on Module to determine the time
required to fill a finite, 6 meter high, 7.5 m2 cross sectional area discharge
reservoir and to turn off the pump when the tank is full.

SSL Example
Use the Settling Slurry Add-on Module to determine the size of the pump
required when the fluid is 25% sand by volume and is being pumped from an
open supply vessel with a liquid surface elevation of 1.5 meters to an open
receiving tank with a liquid surface elevation of 3 meters.

Step 1. Specify fluid properties
1. Open Analysis Setup

2. Go to the Fluid panel, select Fathom Standard, select Water (liquid), then
click Add to Model

3. On the right, enter a temperature of 21 deg. C (see Figure 5.1)

4. On the Heat Transfer/Variable Fluids panel, select Heat Transfer With
Energy Balance (Single Fluid)

5. Click OK
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Figure 5.1 Fluid panel with Water (liquid) selected and temperature
specified

Step 2. Build the model

A. Place the pipes and junctions
This completes the first two groups of the Analysis Setup. The Pipes and
Junctions group remains undefined. To complete this group, begin by
assembling the model on the Workspace as shown in Figure 5.2.

Figure 5.2 Layout of the pipe system for the Controlled Heat Exchanger
Temperature Example
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B. Define the pipes
With the objects in place, define the input data for the pipes and junctions.
Double-click each pipe and enter the following data in the Pipe Properties
window (or use the Global Pipe Edit window, as discussed in Chapter 3).

For Pipes P1-P10, use
� Pipe Material = Steel - ANSI

� Size = 8 inch (20.3 cm ID)

� Type = STD (schedule 40)

� Friction Model = Standard

� Heat Transfer Model = Adiabatic (Perfectly Insulated)

� Length = use the table below

Pipe Length (meters)

P1 6

P2 1.5

P3 6

P4 6

P5 6

P6 6

P7 6

P8 6

P9 60

P10 30

C. Define the junctions

J1, J9 Reservoirs
1. Liquid Surface Pressure = 0.3 barG (30 kPa (g))

2. Liquid Surface Elevation = 3 meters

3. Liquid Temperature = 90 deg. C

4. Update Density with Temperature = Checked

5. Pipe Depth = 0 meters
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J2 - Pump
1. Inlet Elevation = 0 meters

2. Pump Model = Centrifugal (Rotodynamic)

3. Analysis Type = Pump Curve

4. Click Enter Curve Data then input the following and generate a second
order curve fit for the data:

Volumetric Head

m3/hr meters

0 20

115 18

230 12

J3 - Three-Way Valve
1. Elevation = 0 meters

2. Combined Flow Pipe = P2

3. Split Flow Pipe #1 = P3

4. Split Flow Pipe #2 = P9

5. Open Percentage Data (ignore Flow Area data):

Open Pct. Cv Pipe #1 Cv Pipe #2

0 0 100

100 100 0

6. Actual Percent Open = 75%

J4, J7, J8 - Branches
Elevation = 0 meters

J5, J6 - Heat Exchangers
1. Inlet Elevation = 0 meters

2. Loss Model tab
a. Loss Model = K Factor

b. K = 1400

3. Thermal Data tab
a. Thermal Model = Counter-Flow

b. Heat Transfer Area = 148 meters2
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c. Overall Heat Transfer Coefficient = 280 W/m2-K

d. Secondary Fluid Flow Rate = 90 kg/sec

e. Secondary Fluid Specific Heat = 4.2 kJ/kg-K

f. Secondary Fluid Inlet Temperature = 4.5 deg. C

D. Check if the pipe and junction data is complete
Check the Model Status light in the bottom right of the Quick Access panel. A
green light at this point indicates a fully defined model. A red light indicates
undefined pipes or junctions in the model. If this happens, go back to the
incomplete pipes or junctions, and enter the missing parameters. Alternatively,
open the List Undefined Objects window from the View menu to see the
undefined objects.

GSC problem statement

Use the Goal Seek & Control Add-on Module to determine the valve open
percentage required to maintain a 50 deg. C temperature at branch junction J8
for a reservoir supply temperature of 90 deg. C.

GSC Step 1. Create a scenario for the GSC case

Create a child scenario named GSC Example from the Base Scenario by clicking
Create Child in the Scenario Manager.

GSC Step 2. Activate the GSC Module

Open Analysis Setup then open the Modules panel. Under GSC (Goal Seek &
Control) check the box next to Activate GSC. Make sure the radio button for
Use is selected, as shown in Figure 5.3. In the GSC module, Fathom modifies
variables to achieve specified goals. A unique answer requires one unique
variable for each specified goal. No limit exists for the number of variables and
goals defined, however, keep in mind that a large number of variables and goals
could result in extremely long runtimes and possible non-convergence.

With the GSC module activated, the Goal Seek and Control group appears in the
Analysis Setup. The three items in the group include: Variables, Goals, and
Numerical Controls. Specify the Goal Seek and Control group by entering data
for variables and goals in their respective panels.
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Figure 5.3 Activate GSC from the Modules panel

GSC Step 3. Open the Variables panel

Under the Goal Seek and Control group, select the Variables item to open the
Variables panel, shown in Figure 5.4.

Figure 5.4 Variables panel in the Goal Seek and Control group

GSC Step 4. Add a variable

The Variables panel allows users to create and modify the system variables.
Additionally, you can elect to apply certain variables while omitting others using
the check box in the Apply column.

For this example, add a variable for the Three-Way Valve Open Percentage.
Click New Variable and input the following data, as shown in Figure 5.5
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1. Apply = Checked

2. Object Type = Junction

3. Junction Type = Three Way Valve

4. Object Number and Name = J3 (Three Way Valve)

5. Variable Parameter = Open Percentage

6. Link To = (None)

7. Lower Bound (Optional) = 0

8. Upper Bound (Optional) = 100

Figure 5.5 Variables panel with one variable defined for the Three Way
Valve Open Percentage

Use the Apply column to specify the variables for the Solver to use. This allows
the flexibility to create multiple variable cases, while only applying selected
variables for any given run.

You can use the Link To column to apply the same variable to multiple objects.
This will force parameters to vary identically for different objects.

Upper and lower bounds provide limits during the goal search. This can help
convergence when a logical extreme is known, but can also hurt convergence if
an unrealistic bound is entered and artificially restricts the solution. For this
case, leave the lower bound as 0% and the upper bound as 100%.

GSC Step 5. Add a goal

Goals are the parameters you want to determine. Fathom modifies the specified
variables to achieve the goals. To obtain a unique answer there should be one
goal applied for each variable.

Click on the Goals item to open the Goals panel. You create and modify system
goals in the Goals panel by selecting the goal type, object type, goal parameter,
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criterion, value, and units. You can then select the object to which the goal
applies, and, if applicable, the location on the object at which the goal applies
(e.g., the inlet or outlet of a pipe object).

Click New Goal as defined below and shown in Figure 5.6
1. Goal Type = Point

2. Object Type = Branch

3. Goal Parameter = Temperature

4. Goal Value = 50

5. Goal Units = deg. C

6. Object ID = J8 (Branch)

7. Object Location = Outlet

Figure 5.6 Fathom adjusts Variables to achieve user Goals

As variables and goals are added to a model, Fathom will display symbols
beside the pipes and junctions that have variables or goals applied to them. The
default is a V for variables, and a G for goals. This is illustrated in Figure 5.7.

Note: The goal symbol is not displayed next to objects that are part of a group
goal.
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Figure 5.7 Fathom displays symbols next to objects on the Workspace
that have goals or variables defined

GSC Step 6. Run the model

Click Run Model from the Common Toolbar or Analysis menu. The Solution
Progress window opens and begins iterating. This window displays the Fathom
Solver converging on the answer. After the Solver converges, view the results
by clicking Output at the bottom of the Solution Progress window.

When using the GSC module, a new area appears in Solution Progress that
shows the specific progress of the GSC module. As it makes progress, the Best
(Lowest) value will decrease towards zero. The field in the far right displays
how many complete hydraulic solutions have been run.

After completion click the Output button at the bottom of the Solution Progress
window.

GSC Step 7. Examine the results

The results of the GSC analysis are shown in the General Output section.

The GSC Variables tab shows the final values for the variable parameters, as
shown in Figure 5.8. The GSC Goals tab shows the values achieved for the
goals, as shown in Figure 5.8.
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Figure 5.8 The final GSC Variable values are shown on the GSC
Variables tab in the Output window General section

Figure 5.9 The final GSC Goal values are shown on the GSC Goals tab in
the Output window General section

Note: The Actual and User values should be close if the GSC module was
successful. If not, a warning will appear.

GSC analysis summary

For this example, the goal of 50 deg. C was achieved for the temperature at
branch junction J8 as shown in Figure 5.9. The open percentage required for the
Three-Way Valve to achieve a temperature of 50 deg. C at Branch J8 is about
79.3%, as shown in Figure 5.8.

XTS problem statement

Use the Extended Time Simulation Add-on Module to determine the time
required to fill a finite, 6 meter high, 7.5 m2 cross sectional area discharge
reservoir and to turn off the pump when the tank is full.

XTS Step 1. Create a child scenario for the XTS case

Create a child scenario from the Base Scenario for the XTS case by selecting the
Base Scenario, then clicking Create Child in the Scenario Manager in the Quick
Access Panel. Name the child XTS Example.

XTS Step 2. Activate the XTS Module

Open Analysis Setup then open the Modules panel. Under XTS (Extended Time
Simulation) check the box next to Activate XTS. Make sure the radio button for
Transient is selected.
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If prompted, select Yes to disable heat transfer. The XTS module does not
perform heat transfer calculations. After enabling the XTS module, the Heat
Transfer/Variable Fluids panel automatically switches the selection to Constant
Fluid Properties, if not already selected.

With the XTS module activated, the Transient Control group appears in the
Analysis Setup.

► Important: The XTS and GSC modules can be used in the same run to simulate
control functions over time, but that is not required for this example. Before
proceeding, make sure the GSC module is not enabled by either unchecking the
Activate GSC box or selecting the Ignore radio button in the Analysis Setup.

XTS Step 3. Modify the existing model

When using the XTS module, reservoirs may be defined as finite sized tanks.
Specify the J9 Reservoir as a Finite Open Tank with the following data and as
shown in Figure 5.10:

J9 - Reservoir
1. Name = Discharge Reservoir

2. Tank Model = Finite Open Tank

3. Known Parameters Initially = Both Parameters

4. Cross-Sectional Area = Constant, 7.5 meters2

5. Liquid Height = Height from Bottom, 0 meters

6. Liquid Surface Pressure = 0.3 barG (30 kPa (g))

7. Tank Height = 6 meters

8. Pipe Elevation = 6 meters

9. Tank Bottom Elevation = 6 meters
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Figure 5.10 J9 Reservoir specified as a finite open tank

J3 Three-Way Valve
1. Actual Percent Open = 79%

Check if the pipe and junction data is complete
Turn on Show Object Status from the View menu to verify that all the necessary
pipe and junction data is entered. If so, the Pipes and Junctions group in the
Analysis Setup will have a checkmark. If not, the incomplete pipes or junctions
will have their number shown in red. If this happens, go back to the incomplete
pipes or junctions and enter the missing data. Alternatively, open the List
Undefined Objects window from the View menu to see the undefined objects.

XTS Step 4. Specify transient output time format

Open the Output Control window and navigate to the Format & Action tab. On
the bottom-right, the Time Simulation Formatting section controls the units
displayed in the transient output data.

Set the Time Simulation Formatting units to minutes, as shown in Figure 5.11,
and then select OK to close the window.
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Figure 5.11 Adjusting the Time Simulation Formatting to minutes

XTS Step 5. Activate transient analysis

You can turn the XTS module on and off to run steady-state models using
Fathom. Use this feature to check the model steady-state solutions before
attempting to run a transient case.

Toggle the time simulation mode between Steady Only and Transient from the
Time Simulation option in the Analysis menu or from the Modules panel in
Analysis Setup. To run a transient analysis using XTS, select the Transient time
simulation option, as shown in Figure 5.12.

Figure 5.12 Transient Analyses are activated from the Analysis menu
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XTS Step 6. Open transient control

XTS module transient simulations are controlled through the Simulation
Duration panel. You can access the Simulation Duration panel by selecting
Transient Control from the Analysis Menu, navigating to the Simulation
Duration item in Analysis Setup, or by clicking the Simulation Duration shortcut
on the Common Toolbar. When the time simulation mode is set to Steady Only,
Fathom will ignore the input in the Simulation Duration panel. When Fathom is
set to perform a transient analysis, the Transient Control becomes a required
item before the model can run.

Use the Simulation Duration panel to specify transient start and stop times, set
time steps, specify the number of output points that are saved to the transient
output file (allows XTS to do transient calculations with a small time step while
limiting the size of the transient data output file), and adjust solution parameters
for finite tank liquid level calculations.

► Set the Start Time to 0 minutes and the Stop Time as 45 minutes, with a time
step of 1 minute. The output will be saved to the output file for every time step.
The Transient Control window should appear as shown in Figure 5.13.

Figure 5.13 The Transient Control group is used to specify transient run
times and time step sizes

XTS Step 7. Set up the pump transient

In the XTS module, you can define transients for junctions. These transients
include events such as valves opening and closing and pumps starting and
tripping. Transients for junctions are defined as either time-based or event-based
transients. A time-based transient starts at a specified absolute time. Event based
transients initiate when a defined criteria is reached (such as a specified pressure
in a particular pipe).
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There are three types of event transients for junctions: single event, dual cyclic,
and dual sequential. Single event transients are events that occur only once in a
simulation. Dual cyclic events are two transient events that repeat one after the
other as many times as the event trigger occurs during a simulation (such as a
valve closing then reopening). Dual sequential transient events are two transient
events which occur one after the other, without repeating.

For this example, set a single event-based transient on the pump so the pump
speed decreases from 100% to 0% in 10 seconds when the liquid level in the
discharge tank reaches 6 meters.

Note: Fathom does not capture waterhammer effects. For fast transient events
where waterhammer, surge pressures, acoustic wave propagation, and forces are
of interest, use Impulse.

Open the Pump Properties window for the J2 Pump and navigate to the
Transient tab. Select the Speed vs. Time option, and under Initiation of
Transient, select Single Event and enter the Transient data as shown below:
1. Event Type = Reservoir Liquid Height

2. Condition = Greater Than or Equal To

3. Value = 6 meters

4. Junction = 9 (Discharge Reservoir)

5. Transient Data = Absolute Values

Time (seconds) Speed (Percent)

0 100

10 0

Note that after entering the transient data in the pump, a red T displays next to
the junction number for the pump on the Workspace. This symbol indicates that
the junction has transient data.
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Figure 5.14 Junction transients are specified on the Transient tabs on the
junction Properties windows

XTS Step 8. Run the model

After defining all of the pipe and junction transient data and transient control
items, the transient model can run. Click Run Model from the Common Toolbar
or Analysis menu.

When the XTS module is in use, the Solution Progress window shows the
progress of the transient analysis. The Time Step is also shown to help identify
the point of failure in the event of a failed convergence. This information
displays below the solution tolerance data, as shown in Figure 5.15.
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Figure 5.15 The Solution Progress window shows the progress of the
transient analysis

After the run finishes, view the results by clicking the Output button.

XTS Step 9. Examine the transient results

The first thing that you should notice after navigating to the Output is that
Critical Warnings Exist, as shown in Figure 5.16. For this scenario, there is a
critical warning because Junction 2 Had Reverse Flow – Pump Head Could Not
Be Predicted (32 minutes). There is also a Warning message alerting you that
the Tank Junction 9 (Discharge Reservoir) began overflowing at 31 minutes.

A Critical Warning is very important and should never be ignored. Examine the
transient results of this scenario to understand why this warning occurs and how
it affects the model.
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Figure 5.16 A Critical Warning Exists because there is reverse flow
through the pump - the warnings and transient results need
review

The Fathom XTS module displays transient output in a number of places in the
Output window.

Each of the summary tables in the General Output section has a companion
transient summary tab which displays the summary data at each time step in the
transient run. The transient summary data for each junction may be expanded or
collapsed by clicking the + or – sign beside the junction data list. Figure 5.17
shows the Reservoir Transient summary tab, with the data for the J1 Reservoir
collapsed, and the J9 Reservoir expanded.

The Quick Graph feature can be used to conveniently plot transient data for
rapid examination in any of the transient Output sections. To use the Quick
Graph feature, place the mouse cursor over one of the cells of data in the column
you wish to examine. Then, right-click with the mouse, and select Quick Graph
from the list of options. Figure 5.17 illustrates how to generate a Quick Graph in
the General Output section for the J9 Reservoir Liquid Height vs. Time. Figure
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5.18 shows the resulting graph. The graph illustrates how the liquid level in the
Reservoir rises with time, as would be expected. The Graph Results window
may also be used to create a full range of graphs related to the XTS transient
output.

Figure 5.17 Access Quick Graphs from any transient data column
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Figure 5.18 Quick Graphs plot transient data from the Output

Consider Figure 5.18 in terms of the Critical Warning, which states that pump
head could not be predicted at 32 minutes due to reverse flow through the pump.
The tank liquid height increases until the pump turns off. The graph then shows
that there is backflow into the system, which causes the Critical Warning.
Furthermore, the Warning that stated Tank Junction 9 began overflowing is due
to the pump event trigger being set equal to or greater than the max tank liquid
height and the timestep resolution being one minute. Note that the reservoir
liquid height reported on the graph and in the Output will be capped at the tank
height, but the XTS module recognizes that the tank would have overflowed and
alerts the user. This is discussed further in the XTS Analysis Summary after
further examination of the transient results.

Similar to the transient summary data, the transient tabs in the Pipe and
Junctions sections of the Output window are used to display the transient data
for each pipe and junction at every time step, as shown in Figure 5.19. This
transient data can be expanded or collapsed in the same manner as in the
General Output transient summaries.

Figure 5.20 shows the transient output data for the pipes and junctions, found on
the Pipes and All Junctions tabs at Time = 5 minutes. The output for all of the
pipes and junctions can be displayed at any time step by using the slider bar
located at the bottom of the Output window.
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Figure 5.19 The Transient tabs show results for all time steps

Figure 5.20 Use the slider to see the output at any time step

The general output section of the Output window displays the junction event
transients on two different tabs. The first tab sorts the events by junction
number, shown in Figure 5.21, and the second tab sorts the events by time in the
order in which they occur.
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Figure 5.21 The occurrence of event transients is recorded in the General
Output section

XTS analysis summary

The transient reservoir data shows that the water in the discharge tank reached a
height of 6 meters in 31 minutes. The event message indicating the pump
transient also initiated at this time confirms this.

The Quick Graph plot (Figure 5.18) shows the increase in the tank liquid height,
until the time when the pump turns off. The XTS module gives a Warning that
the tank would have overflowed due to the pump event being triggered when the
liquid height reaches the maximum height of the tank. To prevent this Warning,
change the event trigger to a lower value for the tank liquid height. The graph
then shows that there is actually backflow through the pump, due to the
hydrostatic pressure of the fluid in the tank. The pump head cannot be calculated
when the pump has reverse flow, and a Critical Warning is displayed in the
Output. A check valve would need to be added to the system to prevent this
situation in the case of pump shutdown.

SSL problem statement

Use the Settling Slurry Add-on Module to determine the size of the pump when
the fluid is 25% sand by volume, and is pumped from an open supply vessel
with a liquid surface elevation of 1.5 meters to an open receiving tank with a
liquid surface elevation of 3 meters.

This example uses a different model than previously used for the GSC and XTS
modules.

SSL Step 1. Create a new blank model and add slurry units
► Select File > New to create a blank model file.

► Open Analysis Setup and disable the XTS module (the GSC module should
also be disabled from the prior XTS example).

► From the Tools menu, open the User Options and select the Unit System >
Preferred Units item. Ensure that the filter is set to either All Units or
Common Plus Selected Industries with the checkbox next to Slurry.
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SSL Step 2. Specify fluid properties
1. Open Analysis Setup.

2. On the Modules panel, under SSL (Settling Slurry), check the box next to
Activate SSL and select the Settling radio button. Note that the items in the
Fluid Properties group have changed.

3. Go to the Carrier Fluid panel, select the Basic (Water) carrier fluid option,
and enter a temperature of 21 deg. C.

4. Go to the Slurry Definition panel and enter the following:
a. Slurry Model = Settling Slurry - Wilson, Addie, Clift

b. Slurry Calculation Method = Detailed

c. Concentration Type = Volume Fraction

d. Amount Solids Added = 25 Percent

5. Go to the Solids Definition panel and enter the following as shown in
Figure 5.22:
a. Solids Specifications = User Specified Solids Added

b. M (Stratification Ratio Exponent) = Calculated

c. Terminal Velocity Parameter, Vt/Vts (Xi) = 1

d. Density = 2.9 S.G. water

e. d50 = 0.0381 cm

f. d85 = 0.0762 cm

6. Click OK to close Analysis Setup.

Figure 5.22 Fully Defined Solids Definition panel
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SSL Step 3. Build the model

A. Place the pipes and junctions
This completes the first two groups of the Analysis Setup. The Pipes and
Junctions group remains undefined. To complete this group, begin by
assembling the model on the Workspace as shown in Figure 5.23.

Figure 5.23 Layout of the pipe system for the Pump Sizing for Sand
Transfer System Example

B. Define the pipes
With the objects in place, define the pipes and junctions according to the

information below.

For all pipes, use
� Pipe Material = Steel ANSI

� Size = 12 inch (30.48 cm ID)

� Type = STD
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� Friction Model = Standard

� Length = use the table below

Pipe Length (meters)

P1 6

P2 150

P3 15

C. Define the junctions

J1 - Reservoir
1. Name = Supply Tank

2. Liquid Surface Elevation = 1.5 meters

3. Liquid Surface Pressure = 0.7 barG (70 kPa (g))

4. Pipe Depth = 1.5 meters

J2 - Pump
1. Pump Model tab

a. Inlet Elevation = 0 meters

b. Pump Model = Centrifugal (Rotodynamic)

c. Analysis Type = Sizing

d. Pump Sizing Parameter = Mass Flow Rate

e. Fixed Flow Rate = 1270 m-tons/hr Solids

2. Slurry De-Rating tab
a. De-Rating Method = ANSI/HI Standard 12.1-12.6-2016

b. Head De-Rating Data, Percent Fines = 0%

c. Head De-Rating Data = Specify Impeller Size Directly

d. Impeller Size = 20 cm

J3 - Elbow
1. Inlet Elevation = 0 meters

2. Type = Standard Elbow (knee, threaded)

3. Angle = 90 Degrees

J4 - Reservoir
1. Name = Receiving Tank

2. Liquid Surface Elevation = 3 meters
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3. Liquid Surface Pressure = 2 barG (200 kPa (g))

4. Pipe Depth = 3 meters

D. Check if the pipe and junction data is complete
Check the Model Status light in the bottom-right of the Quick Access panel. A
green light at this point indicates a fully defined model. A red light indicates
undefined pipes or junctions in the model. If this happens, go back to the
incomplete pipes or junctions, and enter the missing parameters. Alternatively,
open the List Undefined Objects window from the View menu to see the
undefined objects.

SSL Step 4. Run the model

Click Run Model from the Common Toolbar or Analysis menu.

After completion, click Output at the bottom of the Solution Progress window.

SSL Step 5. Examine the results

The Slurry tab shows the slurry results, as shown in Figure 5.24. Here, one can
see that the velocity is 6.674 meters/sec, which is safely above the 3.498
meters/sec max settling velocity. Other pressure drop and relevant slurry data
can be viewed here.

Also shown in Figure 5.24 is the Pump Summary in the General Section. There,
the required pump head is shown as 27.81 meters, and the de-rating head
correction factor (CH) is 0.7887 (the CH parameter is added via Output Control
under the Pump options). Hence, a pump should be selected that can generate
27.81/0.7887 = 35.26 meters of head based on water.

Also of interest is the system curve. Navigate to the Graph Results window, and
then the Graph Parameters tab on the Quick Access Panel. Then select the Slurry
System Curve tab on the right. See Figure 5.25.

By default, the parameter to graph is jm vs. velocity. Select the units of jm as
m/m (height of mixture head divided by pipe length). Check the box for cross-
plotting the water curve and then click the Generate button. The curves are
shown in Figure 5.26.
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Figure 5.24 The Output window shows the Slurry results table in the
center Pipes section and the pump de-rating in the Pump
Summary in the upper General section

Figure 5.25 Data selection for graphing slurry system curve
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Figure 5.26 Slurry system curve and water system curve in the Graph
Results window

SSL analysis summary

The pump head requirements were determined, and a de-rating factor was
calculated according to the ANSI/HI Standard 12.1-12.6-2016. The de-rating
factor for pump head (CH) was used to manually calculate pump head using
water, such that the correct size pump could be selected when looking at
manufacturer data based on water curves. The velocity in each pipe was found to
be higher than the max settling velocity (Vsm) of the sand and water slurry
which ensured that no settling would occur. A slurry system curve was created
to allow the user to see where the system was operating with respect to solids
settling.

98 Fathom 14 Quick Start Guide



C H A P T E R 6

Other Fathom Capabilities

This Quick Start Guide necessarily omitted or had brief coverage of a number of
important Fathom capabilities. This chapter briefly describes some of the
important capabilities not covered.

You can find a number of other example model discussions on the AFT
documentation help website. To view additional examples, open the Help menu
and choose Show Examples or go to docs.aft.com, select the Fathom Help Site,
expand the Examples section in the sidebar, then select Walk-Through
Examples.

Microsoft Excel™ data integration

Fathom includes Excel importing and exporting. An Excel spreadsheet can be
used to vary selected input parameters in multiple scenarios. Selected output can
also be exported to specified Excel sheets and cells.

Integration with other software and data standards

Fathom includes a number of importing and exporting capabilities. Piping
layouts and dimensional data can be imported from GIS Shapefiles (*.SHP) to
build a model. Additionally, CAESAR II Neutral Files (*.CII) can be imported
into Fathom and EPANET Files (*.INP) can be both imported and exported.

Piping Component Files (*.PCF) from AutoCAD Plant 3D, SmartPlant, PDS,
CADWorx, and other software can be imported into Fathom. These options are
all accessed from the File Menu.

Control valve modeling

Fathom can model four types of control valves. They are Pressure Reducing
Valves (PRVs), Pressure Sustaining Valves (PSVs), Flow Control Valves
(FCVs), and Pressure Drop Control Valves (PDCVs).

Fitting library

Fathom offers a library of about 400 fitting losses that can be added to pipes.
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Variable speed pumps

Fathom allows you to model controlled pumps where the control parameter is
flow rate, pressure, or head. The pump speed is varied to meet the setpoint.

Pump impeller trim effects

Fathom can automatically modify pump curve data for user specified impeller
trims. The impeller variations can be based on a percentage from the specified
curve or, if using multiple pump configurations, actual impeller dimensions can
be entered.

Fathom uses standard affinity laws to modify the pump curves. When multiple
curves are entered, Fathom modifies the pump curve by interpolating between
the curves based on impeller size.

Pump viscosity effects

When fluids are viscous, pump performance degrades. Fathom uses methods
published by the Hydraulic Institute for rotodynamic pumps to automatically
adjust manufacturer pump curves.

Model heat transfer between loops and across programs

Heat transfer between loops which are hydraulically isolated can be modeled.
The loops can have different fluids. This is called thermal linking. The Heat
Exchanger Linking feature in Fathom and Arrow streamlines the thermal
analysis of liquid-gas heat exchangers by allowing direct thermal connections
between heat exchanger junctions in gas (Arrow) and liquid (Fathom) systems.
This integration enables both applications to run simultaneously until a
converged solution is reached, eliminating the need for manual iterations. By
automating this process, users can significantly reduce errors, complexity, and
the time spent on iterative adjustments.

Modeling of gas flow in HVAC and ventilation duct systems

Fathom can model incompressible gas flow. Fathom offers support for both
cylindrical as well as rectangular ducts.

Varied pipe geometries including rectangular duct

Five different pipe geometries can be modeled in Fathom. The default geometry
is the cylindrical pipe. The other four geometries are the rectangular duct, the
cylindrical annulus, the noncylindrical pipe, and the helical tube.
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Insulation on inside of pipe/duct

Insulation can be placed on the inside of a pipe or duct, and the effect of reduced
flow area on the pressure drop will be automatically determined. If modeling
heat transfer, the effect of the insulation on the inside will be accounted for.

View input and output data from different scenarios concurrently

Input data from ancestor scenarios can be viewed concurrently in the Model
Data window. Similarly, output data from different scenarios can be viewed
concurrently in the Output window.

Compare input from different scenarios

The Scenario Comparison Tool can be used to compare pipe, junction, and
general model file inputs for any number of scenarios in the model file. This
allows the user to quickly identify differences between scenarios, or to generate
a report on inputs for different cases. Comparisons can also be made within the
Workspace using Scenario Comparison Layers.

Multi-scenario pump vs. system curve graphs

Graphs with multiple pump curves and/or system curves can be generated
directly in Fathom by saving multiple pump vs. system curves to a Multi-
Scenario Pump vs. System Folder in the Graph List Manager. A single graph
can then be generated with curves from different scenarios.

Online pump manufacturer equipment selection

Fathom includes links to various pump manufacturer websites that use
Intelliquip™. Operating data determined by Fathom can be passed to the
website, a pump model can be selected by the user, and the pump performance
data can be transferred back to Fathom for immediate use in the model.

Libraries

Junction components and pipe materials can be saved to libraries for later reuse.
Libraries can be located on local PCs or deployed across local or wide area
networks. The Library Manager allows users to connect to relevant libraries for
their specific pipe system design.

Darby 3-K method for laminar flow

The 3-K method developed by Darby can be optionally used in valves and
elbows. This has particular application in the laminar and transitional flow
regions.
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Equivalent lengths

Standard equivalent lengths can be specified for pipe fittings, valves, and
elbows. This is often used in fire protection systems.

Design Alerts

Design Alerts can be created for pipes and junctions to alert the user that one of
their project constraints has been violated. A common use is maximum and
minimum allowed operating pressure. If the resulting value for that parameter
violates the Design Alert a warning message is given in the Output. Design
Alerts and violations may also be viewed on the Workspace with Design Alert
Layers.

Cost calculations

Material, Installation, and Maintenance costs can be calculated for junctions,
pipes, and fittings based on Cost Libraries which are user-created. In addition,
energy (operation) costs can be calculated for compressors/fans. Time value of
money can be taken into consideration by entering inflation and interest rates.
The results are presented in a Cost Report in the Output.

Retaining and reproducing graphs

Comprehensive graphing features allow users to graph a wide variety of
parameters at single points or along flow paths within their model. Graphs added
to a Graph List are saved so that the graph can be regenerated with the same
styles and customization if changes are made to the model input, or if the user
desires to plot the same graph in multiple scenarios. Multiple graphs can be
shown at the same time. Graphs can be displayed on the Workspace with the
Graph Annotation Tool.

4-Component Slurry Model

The 4-Component Slurry Model is a holistic approach to characterizing how
slurry flows function by considering the combined effects of four slurry flow
regimes: the carrier fluid, pseudo-homogeneous, heterogeneous, and fully
stratified. The model strongly references and utilizes the method of the same
name outlined by GIW Industries Inc.
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Parametric Study Tool

The Parametric Study Tool enables rapid and in-depth simulation analysis,
allowing users to explore a wide range of input parameters efficiently. By
systematically varying inputs, the tool helps identify critical factors affecting
system performance, enhancing sensitivity analysis and optimization. Engineers
can gain clear insights through graphical trends, even in cases where traditional
goal-seeking methods struggle. This approach facilitates better decision-making
by providing visual justifications for key trade-offs, such as cost versus
performance.
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noncylindrical pipes 100

rectangular duct 100

Pipe object 9

Pipe Properties window 22

Use with Global Pipe Editing 43

Pipes

flow direction 12

properties 42

Pressure Drop Control Valve 99

Pressure Reducing Valve 99

Pressure Sustaining Valve 99

Primary Windows 3

Properties windows

using tabs 19

PRV 99
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PSV 99

Pump Configuration window 36

entering pump curve data 36

Pump Curves 36

Pump de-rating 96

Pump Properties window

Turning pumps on and off during
transients 85

Pump Summary

in Output window 37

Pumps

entering curve data 36, 61

impeller trims and affinity laws 100

Internet selection from within AFT
Fathom 101

modeling transients 85

viscosity effects 100

Q
Quick Access Panel 8

pinning 8

Quick Graph

in Output window 88-89

Quick Graph Formatting 35

R
Rectangular duct 100

Reference positive flow direction 12

Reservoir junction 9

Modeling finite tanks during transients 81

Reservoir Transient summary 88

Retaining graphs 102

Reverse Direction 12

Reverse flow 12

Run Model 25, 46, 65, 67, 79, 86, 96

S
Scenario Manager 8, 64, 75, 80

Show Object Status 17, 20, 24, 82

Simulation Duration panel 84

Slurries

Viewing results in Output window 96

Slurry system curves 96

SmartPlant 99

Solution Progress window 25

Solver 25-26

Spray Discharge junction 44

SSL Module 70

setting up slurry a model 92

Stacked Graphs 34

Status Bar 14

T
Three-Way Valve junction 74

Toolbars 13

Toolbox 8, 11

Annotation tool 8

Pipe Drawing Tool 8

Tooltips 8

Transient modeling

Enabling on Analysis menu 83

Output window transient results 87

Setting up finite tanks which fill or drain 81

Specifying time units Output window 82

Transient Control window 84

Turning pumps on and off 85

U
Undefined Objects window 17, 46, 63, 75, 82,

96

User Options 17

V
Variable speed pumps 100

Ventilation systems 100

VFD 100
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W
Workspace window 3, 8

Workspace Layers 31

X
XTS Module 70

Setting up a transient model 80


